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c h a p t e r  1

About CallPilot

This chapter introduces CallPilot, the powerful multimedia messaging system 
from Nortel Networks. CallPilot offers a single solution for managing many 
types of information, including voice mail, fax-mail, e-mail, telephone calls, 
conferencing, calendars, directories, and call logs.

CallPilot enables you to get all the information you need from one source, 
whether through display-based telephone sets, your wireless set, your Windows 
desktop computer, a speech recognition interface, or another personal 
communications device. 

In this chapter 
About this guide 13

Finding your way around CallPilot 25
Enterprise Networking Implementation and Administration Guide 11
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Overview

Introduction
The Enterprise Networking Implementation and Administration Guide provides 
the information and procedures that are necessary to implement Enterprise 
Networking.

Assumptions
This guide assumes that the Meridian Application Server has been correctly 
installed and is operational. If the application has not been installed, then install 
it before proceeding. For installation instructions, refer to the hardware 
installation guide appropriate to your server type.

If the server has been installed but is not operational, refer to the Maintenance 
and Diagnostics Guide for information on troubleshooting your system.
14 CallPilot
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Skills you need

Introduction
You need certain skills and knowledge to use this guide effectively.

Nortel Networks product knowledge
Knowledge of, or experience with, the following Nortel Networks products will 
assist you:

■ previous releases of CallPilot

■ Meridian Mail

PC experience or knowledge
Knowledge of, or experience with, the following PC products will be of 
assistance. This guide does not document the following functionality:

■ Microsoft Windows NT

■ Microsoft Windows 95

■ Microsoft Windows 2000

Other experience or knowledge
Other types of experience or knowledge that may be of use include the 
following:

■ switch configuration and operation (especially trunk group access 
restrictions [TGARs] and network classes of service [NCOS])

■ network management

■ client-server systems

■ flowcharting

■ troubleshooting
Enterprise Networking Implementation and Administration Guide 15
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How this guide is organized

Introduction
The Enterprise Networking Implementation and Administration Guide is 
organized in the sequence of tasks required to successfully implement Enterprise 
Networking for CallPilot. Start at the beginning of the guide and work your way 
through it until all required tasks are completed.

Contents
This guide contains the following chapters:

Chapter title Description

Chapter 1, About CallPilot This chapter describes how to work with the 
CallPilot interface and how to use this guide.

Chapter 2, Getting started This chapter provides an overview of 
Enterprise Networking.

This chapter describes the features supported 
by Enterprise Networking and how Enterprise 
Networking works.

This chapter also provides a high-level 
overview of the tasks that are performed 
during implementation.

Chapter 3, Gathering information This chapter explains how to gather the 
information required to implement Enterprise 
Networking.

Chapter 4, Configuring the switch for 
Enterprise Networking

This chapter explains how to configure the 
switch for Enterprise Networking.

Chapter 5, Configuring CallPilot for 
Enterprise Networking

This chapter describes how to configure 
CallPilot for Enterprise Networking.

This chapter describes every box that must be 
completed and provides detailed procedures.
16 CallPilot
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Chapter 6, Adding sites to Enterprise 
Networking

This chapter describes how to configure the 
local site. This chapter also describes how to 
add and configure every site in the messaging 
network that uses Enterprise Networking to 
exchange messages with local site.

This chapter describes every box that must be 
completed and provides detailed procedures.

Chapter 7, Testing and backing up 
Enterprise Networking

This chapter describes how to test the 
implementation of Enterprise Networking to 
ensure that it is properly configured. This 
chapter also describes how to perform a 
backup of the system.

Chapter 8, Maintaining Enterprise 
Networking

This chapter explains how to perform both 
regularly scheduled maintenance tasks and 
as-required maintenance tasks.

Chapter 9, Troubleshooting Enterprise 
Networking

This chapter provides information to identify 
and solve problems with Enterprise 
Networking.

Chapter title Description
Enterprise Networking Implementation and Administration Guide 17
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Related information products

Introduction

The following CallPilot technical documents are stored on the CD-ROM that you 
receive with your system. The documents are also available from the following 
sources:

■ CallPilot Manager 

■ My CallPilot

■ the Nortel Networks Partner Information Center (PIC) at 
http://my.nortelnetworks.com

You require a user ID and a password to access the PIC. If you do not have a PIC 
account, click Register to request an account. It can take up to 72 hours to 
process your account request.

You can print part or all of a guide, as required.

Note: To order the documents that are available in printed format, contact your 
Nortel Networks sales representative.

Planning and migration guides

Use these guides before you install CallPilot to help plan your system, or to plan a 
migration of data from Meridian Mail to CallPilot: 

Document title NTP number

Installation and Configuration Planner —

Planning and Engineering Guide 555-7101-101

What’s New Guide 555-7101-901
18 CallPilot
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Installation and configuration guides

The following guides describe how to install the following: 

■ CallPilot server hardware and software

■ desktop messaging and My CallPilot software 

Administration guides

The following guides provide specialized information to help you configure 
administer and maintain CallPilot, and use its features: 

Document title NTP number

Desktop Messaging and My CallPilot 
Installation Guide

555-7101-505

Installation and Configuration Guide for your server 
model 

This is a binder that contains the following five 
documents:

■ Part 1: Installation and Maintenance Overview

■ Part 2: <Server model> Server Hardware 
Installation

■ Part 3: <Switch name> and CallPilot Server 
Configuration

■ Part 4: Software Installation and Maintenance

■ Part 5: <Server model> Server Maintenance 
and Diagnostics

Refer to the 
CallPilot 
Installation and 
Configuration 
binder for NTP 
numbers.

Document title NTP number

Administrator’s Guide 555-7101-301

Reporter Guide 555-7101-310

Application Builder Guide 555-7101-325
Enterprise Networking Implementation and Administration Guide 19
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Networking guides

The following guides describe how to plan, install, set up, and troubleshoot the 
CallPilot networking services: 

Note: For instructions on how to configure the networking services on CallPilot, 
refer to the CallPilot Manager online Help.

Desktop Messaging and My CallPilot Administration 
Guide

555-7101-503

Meridian Mail to CallPilot Migration Utility Guide 555-7101-801

Document title CallPilot release NTP number

Networking Enhancements Guide 2.0 555-7101-507

Networking Planning Guide 1.0 555-7101-100

NMS Implementation and 
Administration Guide

1.0 555-7101-302

AMIS Networking Implementation 
and Administration Guide

1.0 555-7101-303

Enterprise Networking 
Implementation and Administration 
Guide

1.0 555-7101-304

Integrated AMIS Networking 
Implementation and Administration 
Guide

1.0 555-7101-305

VPIM Implementation and 
Administration Guide

1.0 555-7101-306

Document title NTP number
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End user guides

The following guides are intended for CallPilot end users, such as telephone set 
users and desktop messaging users:

Document titles

Unified Messaging Quick Reference Card

Unified Messaging Wallet Card

Unified Messaging What’s New Card

Command Comparison Cards

Menu Interface Quick Reference Card

Alternative Command Interface Quick Reference Card

Multimedia Messaging User Guide

Speech Activated Messaging User Guide

Desktop Messaging User Guides

My CallPilot User Guide
Enterprise Networking Implementation and Administration Guide 21
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Troubleshooting

The CallPilot Troubleshooting Reference describes symptoms that can appear on all 
CallPilot server platforms, and describes ways to resolve them. 

The CallPilot Troubleshooting Reference is intended for Nortel Networks 
distributors and technical support representatives; therefore, it is not part of the 
customer documentation package. Nortel Networks continually updates the 
CallPilot Troubleshooting Reference, which is available from the Nortel Networks 
Partner Information Center (PIC) at http://my.nortelnetworks.com.

You require a user ID and a password to access the PIC. If you do not have a PIC 
account, click Register to request an account. It can take up to 72 hours to process 
your account request.

Note: If you are not a Nortel Networks distributor, then contact your Nortel 
Networks technical support representative for assistance.

Using online sources

CallPilot administration online Help
The CallPilot Manager and CallPilot Reporter software contain administration 
online Help areas that provide access to 

■ technical documentation in Acrobat PDF format

■ online Help topics in HTML format

To access online information, use either of the following methods:

■ Click the orange Help button at the top of any page to access the Administration 
Help area. 

■ Click the grey Help button on any page to display a topic that relates to the 
contents of the page. 

For more information about using these Help systems, access the CallPilot Manager 
Help, open the Getting Started book, and click “Navigating CallPilot Manager 
Help.”

The Application Builder software contains a Windows Help system as well as 
context-sensitive Help (available by clicking the ? button and then a field or label).
22 CallPilot
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CallPilot end-user online Help
The My CallPilot software contains a Useful Information area that provides access 
to the end-user guides in PDF format. 

To access online Help for the currently selected My CallPilot tab, click the Help 
button on the upper-right corner of the My CallPilot page. 

Desktop messaging provides product-specific Windows Help for groupware 
clients (Microsoft Outlook, Novell GroupWise, and Lotus Notes). The stand-alone 
version of CallPilot Player also provides addressing and troubleshooting 
information for Internet mail clients.

Contacting technical support

Contact your distributor’s technical support organization to get help with 
troubleshooting your system.
Enterprise Networking Implementation and Administration Guide 23
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Conventions

Commands documented in procedures
As in many other Windows-based applications, in CallPilot you can execute a 
command in several ways.  For example, to copy text you can choose any of the 
following methods:

■ Select Copy from the Edit menu.

■ Click the Copy button on the toolbar.

■ Type the keyboard shortcut Control + C.

The procedures in this guide use only the first method: selecting a command 
from a menu.

Navigation information in procedures
A Getting there statement precedes each procedure in this guide.  This 
statement summarizes the steps you must take to navigate to the window or tab 
where you carry out the procedure.

All Getting there statements start at the Nortel System Management 
Interface (SMI) window.  This assmues that you logged on and selected the 
appropriate system.  Eac item mentioned after the Nortel SMI window 
represents an icon, window or tab that makes up the path to the final destination.

Example
To define special mailboxes, such as the broadcast mailbox, you must be on the 
Mailboxes tab.  

Getting there  Nortel SMI > Meridian Application Server > CallPilot > Message 
Administration

After you double-click Messaging Administration, the Message Administration 
Properties sheet displays.  Click the Mailboxes tab.
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Finding your way around CallPilot

In this section
Connecting to CallPilot 26

Multi-administrator access 34

Error handling in property sheets 36

Using the online Help 39
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Connecting to CallPilot

Introduction
To perform administrative tasks, or to build or work with CallPilot applications, 
you must first connect to the Meridian Application Server (the MAS server). 
The MAT Navigator and the System Management Interface (SMI) work together 
to give you access to your system and sites.

Selecting a system-the MAT Navigator
The first step in logging in is to launch the MAT Navigator, which has its own 
password. The MAT Navigator connects your administration client to the MAS 
server. It displays all your sites and systems and enables you to select one to 
work on.
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Selecting a program—the System Management Interface (SMI)
When you select a system from the MAT Navigator, you are prompted for a 
second password. At this point, the SMI window for the selected system or site 
displays.
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The SMI gives you quick and easy access to your system or sites. The SMI uses 
a navigation tree to display the system's hierarchy. In the tree, icons represent the 
folders and programs. Double-click a folder icon to view its contents. Folders 
can contain programs and other folders. Double-click a program icon to run the 
associated program.

Selecting an object-list views
When you launch certain programs, the first thing you see is a list view. The list 
view displays all the objects of a certain type (such as mailbox classes) that are 
currently defined in the system. The list view includes predefined objects as well 
as those defined by an administrator. From the list view window, you can select 
a specific object to work on.
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Viewing and changing properties
Select an object and display its properties by

■ double-clicking it or

■ single-clicking it and selecting Properties from the File menu

■ right-clicking it and selecting Properties from the popup menu

Entering data and choosing options-property sheets
A property sheet is displayed when you view an object selected from a list view. 
Certain programs, such as Messaging Administration, display a property sheet 
immediately after launching. Property sheets have one or more tabs. Each tab 
has fields, referred to as boxes, in which you can type data or from which you 
can select options.
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Most CallPilot property sheets look like the following:
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Some property sheets are divided into two panes. When a box is checked in the 
left pane, the selected capabilities are enabled and you can access the associated 
tabs. Select a tab by clicking its name in the left pane or by clicking the tab in the 
right pane. These property sheets look like this:

Mandatory boxes
If the name of a box is underlined, the box is mandatory, and you must fill it in. 
You cannot save if any mandatory boxes are empty.
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Common buttons
The following buttons appear on most property sheets:

Using the toolbar buttons
For easier access, some of the more common tasks, such as Print and Save, are 
represented as buttons on the toolbar.

The following buttons are used throughout CallPilot. Buttons or icons specific to 
certain CallPilot functions, such as backups and archives, are documented in the 
relevant chapters.

Button Description

Save Saves all changes made on any of the tabs in a property 
sheet and closes the property sheet. Therefore, save only 
when you have made the necessary changes on all tabs.

Cancel Closes the property sheet without saving any changes. 

Print Prints the contents of all tabs in the property sheet.

Help Displays Help for the current tab. From this overview 
Help topic, you can access other Help topics, the index, 
and the search function.

Toolbar button Description

Saves any changes you have made and then transfers 
all the application's data to the server.

Opens the Print dialog box and prints the active file or 
the objects you specify.

Deletes the object you select.
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Displays the properties of the object you select.

Displays the Help topics window.

Explains the next menu item or screen object you 
click. In a window, there is an arrow. On tabs or in 
dialog boxes, there is no arrow.

Opens the New dialog box, where you identify the 
properties of the object you are creating. The button 
looks different in different applications.

Displays the Open dialog box, where you select an 
object to open. The button is different in different 
applications.

Reloads the current page and displays the changes you 
have made.

Enables you to select how the system displays icons.

Toolbar button Description
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Multi-administrator access

Introduction
You can create multiple administrator accounts to make administering CallPilot 
easier and more efficient. Multiple accounts enable administration 
responsibilities to be distributed among a number of people. Therefore, certain 
administrators can specialize in certain tasks, such as maintaining users, 
performing backups, analyzing reports, or creating multimedia services.

Access classes
For security reasons, administrators should be given access only to those parts of 
the system that relate to their role. For example, an administrator who is 
responsible only for creating multimedia services should have access only to 
Application Builder and the Service Directory Number Table.

Each administrator account is assigned an access class. An access class is a list 
of the parts of the system and the level of access allowed. The access levels are 
as follows:

■ create/delete (enables an administrator to delete objects such as users and 
services)

■ edit

■ view

■ none

For example, an administrator may be able to create or delete objects in 
Application Builder but only view User Templates.
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Simultaneous access
Multiple administrators can log in to CallPilot at the same time without 
overwriting other work.

If you are the first to log in to a particular resource, such as a specific mailbox 
class or user profile, and another administrator tries to access the same resource, 
a dialog box appears to inform you of the other administrator. At this point, you 
can do one of the following:

■ Keep editing.

■ Save your changes, and release the resource to the other administrator.

■ Cancel your changes, and release the resource to the other administrator.

If you do not respond to this prompt within two minutes—because you are away 
from the terminal, for example—the system releases the resource so that others 
can access it. If this happens, all your unsaved changes are lost.

An administrator who accesses a resource that is currently being edited sees a 
read-only view of the property sheet in which all boxes are dimmed. This 
indicates that the resource is currently locked. The administrator is not notified 
when the resource is released, but must try to access the property sheet again to 
see whether its status has changed.

If a user tries to log on to a mailbox while an administrator is changing the 
profile, the user is unable to log on and receives a message that says the mailbox 
is in use.

Refreshing screens
Because multiple administrators can access the same database at the same time, 
a Refresh command is available from the View menu to ensure that the view you 
are seeing is the most up-to-date.

For example, if you are viewing a list of users when another administrator 
deletes a user, the only way to see the change is to refresh the screen. You 
should, therefore, refresh the screen regularly.
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Error handling in property sheets

Introduction
If you make certain types of errors while entering data, you are not able to save 
your changes until you correct the errors. For example, if you leave a mandatory 
box empty, you receive a message prompting you to fix it.

Note: These errors do not show up in the Event Browser or Alarm Monitor 
because the errors relate only to data entry and are not operational problems.

How error handling works
There are two types of error messages.

Type 1
If you get this type of error message, click OK, and then fix the problem 
described in the message before you try to save again.
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Type 2
If you get this type of error message, click OK to see a list of errors.

Double-click an error from the list. Your cursor is automatically placed in the 
box where the error was made so that you can correct it.
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For example, if you double-click the second error, the Remote notification tab is 
displayed, with the cursor in the Target number box.
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Using the online Help

Introduction
While administering or maintaining CallPilot, you may have questions about the 
purpose of certain boxes and buttons, or need more information about 
completing certain tasks. Online Help provides brief answers to the questions 
"What's this?" and "How do I...?"

Context-sensitive Help
If you need to know the purpose of a particular box or button, use 
context-sensitive Help.
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To access context-sensitive Help

1 Click the  icon in a window or the  icon on a tab or in a dialog 
box.

2 Point to the box or button for which you want more information, and click.

Result: A pop-up description of the selected object is displayed.
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Procedures
If you need to know how to do something, you can access procedures to lead 
you through a task.

High-level tasks
In some cases, high-level tasks take you through longer procedures. These tasks 
also provide you with navigation to the step-by-step procedures they include.

For example, setting up Delivery to Telephone requires several procedures. The 
high-level task summarizes these procedures. You click the gray buttons within 
the task to open the step-by-step procedures. The high-level task remains on 
your screen so that you can continue to use it to move through the procedures.
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Overview topics
Overview topics provide brief descriptions of tabs, features, and the tasks 
carried out from the tabs. However, the online guides contain more detailed 
feature descriptions.

To access overview topics
Click the Help button on a tab.

To find information in Help
You can look up procedures and overview topics in the following ways:

1 From the Help menu, select Help Topics.

Note: You can also press F1 on the keyboard.

2 Go to one of the following tabs:

■ To see the table of contents of all the Help topics, select the Contents 
tab.

■ To look up a subject alphabetically, select the Index tab.

■ To do a full-text search to find topics that contain the words you enter, 
select the Find tab.
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Getting started

Enterprise Networking is one of the networking solutions offered by CallPilot. 
Enterprise Networking uses a proprietary protocol, the Enterprise Networking 
protocol, to exchange messages.

This chapter introduces Enterprise Networking and provides a basic overview of 
the Enterprise Networking implementation process.

In this chapter
About Enterprise Networking 45

Implementing Enterprise Networking 59

How Enterprise Networking works 65

How Enterprise Networking handles messages 75
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About Enterprise Networking
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Overview

Introduction
Enterprise Networking is one of the networking solutions offered by CallPilot. 
This chapter introduces Enterprise Networking and provides a basic overview of 
its implementation process.

You must be familiar with the basic concepts of messaging networks, dialing 
plans, and protocols. To review these concepts, consult the Networking Planning 
Guide.

Definition: Enterprise Networking
Enterprise Networking is a CallPilot networking solution that is used to transmit 
messages between users at different sites in a private messaging network.

The following diagram is a conceptual illustration of how Enterprise 
Networking works:
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Protocol
Enterprise Networking uses a proprietary analog protocol that is based on 
extensions to the Audio Messaging Interchange Specification (AMIS) protocol. 
Like the AMIS protocol, the Enterprise Networking protocol uses dual-tone 
multifrequency (DTMF) signaling.

Since DTMF signaling is a global standard, Enterprise Networking can be used 
globally.

Advantages of Enterprise Networking protocol
The Enterprise Networking extensions to the AMIS protocol offer important 
advantages.

The Enterprise protocol requires less resource consumption and costs less to 
operate.

For example, when a single message is sent to multiple recipients at the same 
remote site using AMIS Networking, you make one call for each recipient. With 
Enterprise Networking, you make only one call.

The Enterprise protocol also supports a longer voice message length than AMIS.

The Enterprise Networking extensions also support additional CallPilot features 
that are not supported by AMIS Networking.

Message transmitted with Enterprise Networking
A message that you transmit with Enterprise Networking consists of two parts:

■ a message header consisting of

● the mailbox numbers of the sender and the recipient or recipients

● an indication of whether the message is a regular message or a non-
delivery notification (NDN) message

■ the recorded message
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Enterprise site ID numbers
Every messaging system in the messaging network is called a site. A site 
consists of a server and one or more switches.

If you install Enterprise Networking on the messaging network, every site in the 
messaging network that exchanges messages with the site using Enterprise 
Networking needs a unique site ID number.

Enterprise Networking is the only networking solution that uses site IDs.

If your implementation of Enterprise Networking is an upgrade of an existing 
voice messaging system that used Enterprise Networking, maintain the site ID 
numbers of the previous system.

Complex network with Enterprise Networking
You can implement Enterprise Networking on a complex messaging network 
that combines several networking solutions. A messaging network is often both 
open and private, combining various protocols.

The following diagram illustrates a complex network that includes sites with 
Network Message Service (NMS), AMIS Networking, VPIM Networking, and 
Enterprise Networking implemented.

Because Enterprise Networking is implemented in this messaging network, 
every site has a unique site ID number.
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While the sites have more than one networking solution implemented, only one 
protocol is used between any two sites. 

Example: 
Because Site 4 and Site 2 both have Integrated AMIS Networking and Enterprise 
Networking implemented, you use only one protocol to send messages between 
the sites. The network administrators of Site 4 and Site 2 must agree on which 
protocol to use.
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CallPilot and Enterprise Networking

Introduction
Enterprise Networking supports most of the features offered by CallPilot.

Enterprise Networking features
The following table lists the CallPilot features that are supported by Enterprise 
Networking.

For detailed information about CallPilot features, consult the Basic 
Administration Guide.

CallPilot feature Supported Notes

Call Sender Yes This feature can be used for both call 
answering and composed messages from 
network users if

■ the calling line identification (CLID) is 
present in the message, or

■ the mailbox numbering plan follows the 
dialing plan, or

■ a remote user entry is added for the 
network user

Names Across the Network Yes

Name Addressing Yes Name addressing is available if users at the 
remote site are defined as remote users at 
the local site. This can be done 
automatically with Names Across the 
Network or manually by the administrator.

Personal Distribution Lists Yes This feature is available if users at the 
remote site are defined as remote users at 
the local site, which can be done by Names 
Across the Network.
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Shared Distribution Lists Yes A remote user is required. A network 
address cannot be entered into the shared 
distribution list unless the address 
corresponds to a remote user.

Multiple Recipients Yes The Enterprise Networking message 
contains all the recipients of the message 
who are at integrated sites. Recipients at 
open sites are not included.

Reply To Yes This feature can be used with all network 
messages. It can also be used with call 
answering messages left by network users if 
the calling line identification (CLID) is 
present on the message and all other 
conditions listed for Call Sender are met.

Reply All Yes This feature works with all recipients at 
integrated sites. It does not include 
recipients at open sites.

User’s Actual Personal 
Verification

Yes The user’s personal verification is played to 
callers in voice messaging scenarios if 
recipients are defined as remote users at the 
local site. AutoAdd or Names Across the 
Network can be used to create the user’s 
personal verification.

Administrator-Recorded 
Personal Verification

Yes The administrator can record a personal 
verification for remote users who are 
defined at the local site.

Remote Site Spoken 
Names

Yes A spoken name can be recorded for each 
remote site when configuring a remote site.

Private Tag Yes Messages tagged as private are announced 
to the recipient and may not be forwarded 
by the recipient to anyone else.

CallPilot feature Supported Notes
Enterprise Networking Implementation and Administration Guide 51



Getting started  Standard 1.0
Acknowledgment Tag Yes Acknowledgment tags result in a message 
to the sender indicating that the message 
was actually listened to.

Urgent Tag Yes Messages tagged as urgent trigger urgent-
related features, such as remote notification 
or message waiting indication. Urgent 
messages are given priority for transmission 
as determined by the scheduling 
parameters.

Economy Tag Yes

Received Time Announced Yes The time when the message was deposited 
into the mailbox is announced to the 
recipient. The time reflects the time zone of 
the recipient.

Sent Time Announced Yes The sent time announced to the recipient 
reflects the time zone of the sender, not the 
recipient.

120-Minute  Messages Yes Enterprise Networking supports messages 
containing up to 120 minutes of voice, 
including any attachments.

Sender’s Name (Text) Yes This feature is supported only if American 
English character set (ASCII 32-126) is 
used.

Recipient’s Name (Text) Yes If the recipients are defined as remote users, 
their names are provided.

This feature is supported only if American 
English character set (ASCII 32-126) is 
used.

Message Subject (Text) Yes This feature is supported only if American 
English character set (ASCII 32-126) is 
used.

CallPilot feature Supported Notes
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. 

Sender’s Department No

Timed Delivery Yes Any message can be tagged for future 
delivery.

CallPilot feature Supported Notes
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Names Across the Network

Names Across the Network
Names Across the Network is a feature that automatically adds temporary 
remote users to a local database and maintains them.

You can use Names Across the Network if you have Enterprise Networking 
installed on your system.

Incoming and outgoing messages
You enable Names Across the Network for incoming and outgoing messages 
separately. A temporary remote user can be added when

■ A local user addresses a message to a user at a remote site.

■ A user at a remote site addresses a message to a local user.

When you select Names Across the Network for incoming messages, you add 
temporary remote users from all sites in the messaging network.

However, because outgoing messages must carry additional information with 
them, which results in longer transmission time, you can select Names Across 
the Network for outgoing messages for individual sites. For example, you might 
select the feature for outgoing messages to a site that does not incur long-
distance toll charges, but clear the feature for a site that incurs these charges.

Examples
The following examples describe a messaging network consisting of five sites.

Example 1
As the local administrator of the Helsinki site, you set your system to receive 
Names Across the Network by selecting the Add/Update Remote Users option. 
You receive messages from all other sites that are configured to send the 
information.
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However, when you configure information about the remote servers in your local 
database, you clear the Send Local User Information to this Server option for the 
sites to which you do not want to send remote user information. In this case, you 
do not want to incur the extra long-distance toll charges associated with Names 
Across the Network. Therefore, you clear the Send Local User Information to 
this Server option for Cairo and Paris.

Because Lammi and Korso-Rekola are near Helsinki and do not incur long-
distance toll charges, you allow local user information to be sent to these sites.

However, Names Across the Network is also affected by the way the network 
administrator at a remote site configures the system.
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Example 2
In this example, the network administrator in Lammi decides to clear the Send 
Local User Information to this Server option when configuring the Helsinki 
remote server in the local messaging database. This means that even though you 
are willing to receive Names Across the Network from Lammi, messages are not 
sent to your site in Helsinki.

In this case, when a user from Helsinki sends a message to a user in Lammi, the 
Helsinki user is not added to the Lammi database as a remote user.

To add remote users with Names Across the Network
The setting to add remote users with Names Across the Network is on the 
Messaging Network Configuration page for your local server. 

This setting controls your local server. You must coordinate with the system 
administrator of each remote site with which you want to enable Names Across 
the Network. You can use Names Across the Network only with remote sites that 
have Enterprise Networking installed.
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When remote users are added and updated
Names Across the Network adds a temporary remote user to the local site when 
a user at the remote site sends a network message to a user at the local site. The 
remote user information is taken from the header of the message that is received.

Limitations
Names Across the Network has the following limitations:

■ Users at remote sites are added to your system as temporary remote users 
only when messages are received from them. Users at remote sites who do 
not send network messages are not added to your system, even if they are 
regularly name-dialed or have messages sent to them.

■ Operational measurements are not collected for remote users.

■ If the sender’s site does not have mailbox numbers that match the dialing 
plan, the Call Sender and Name Dialing features are not available.

■ While the nightly audit is in progress, temporary remote users cannot be 
added or updated.

■ Only 18 characters of the remote voice user’s text name are sent.

IF THEN

the first and last names are 18 
characters or less

the first and last names of the user are 
sent.

the initials and last name are 18 
characters or less

the initials and last name of the user are 
sent.

the last name only is 18 characters 
or less

only the last name is sent.

the last name is longer than 18 
characters

only the last name, truncated to 18 
characters, is sent.
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Outgoing Enterprise Networking sessions
When the local site initiates an Enterprise Networking session to a remote site, 
the two sites negotiate whether spoken names are sent. This negotiation occurs 
as follows:

Time stamps updated
When a message is received from a user who already exists in the local database 
as a temporary remote user, the time stamp of the remote user is updated with 
the current date and time.

IF THEN

the local site chooses to send spoken 
names and the remote site has selected the 
Add/Update Remote Users on this Server 
option

■ the local site includes the sender’s text and 
spoken name with each message.

■ the remote site adds or updates the 
sender’s remote user information.

the local site chooses not to send spoken 
names and/or the remote site has not 
selected the Add/Update Remote Users on 
this Server option

■ the local site does not include the spoken 
names for the senders.

■ the remote site does not add or update the 
sender’s remote user information.
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Implementing Enterprise Networking

In this section
Overview 60

Implementation in a complex messaging network 64
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Overview

Introduction
Planning is critical to successfully implement Enterprise Networking. Before 
you begin to implement Enterprise Networking, you must understand the basic 
implementation process and know what information to provide.

The process for planning the implementation of a CallPilot networking solution 
is described in detail in the Networking Planning Guide. The following 
overview assumes that you are familiar with this description.

Before you begin
This guide makes the following assumptions:

■ The switch is installed and configured.

■ Sufficient trunks that connect the switch to a public switch are available.

■ CallPilot is installed and configured, except for networking.

■ If implemented on the local site, Network Message Service (NMS) is fully 
implemented.

■ If implementation is an upgrade from Meridian Mail, all legacy information 
is available or is migrated.

■ Contact is made with the network administrators of the remote sites.

Fulfill all of these requirements before you continue with the implementation of 
Enterprise Networking.

Implementation steps
To implement Enterprise Networking, you must complete the following steps:

■ Gather information for the network.

■ Configure the switch for Enterprise Networking.

■ Configure CallPilot for Enterprise Networking.

■ Add and configure the sites that use Enterprise Networking to the local 
network database.

■ Test and back up the system.
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Gather information for the network
The first step in implementing Enterprise Networking is to gather the 
information required during the configuration. You must gather information 
about

■ the switch configuration

■ the remote sites

You must also create a network representation.

Gather information from the switch
Much of the information you need to implement Enterprise Networking is 
available in the switch database.

For example, before you begin to implement networking, the switch is set up to 
make telephone calls to all the remote sites. The dialing plan exists in the switch 
database. You must reflect the dialing plan settings when you configure 
CallPilot for networking.

Ask the administrator who is responsible for the switch configuration to provide 
this dialing plan information.

Create the messaging network representation
You need information about the other sites in the messaging network to create a 
messaging network representation.

You must create a detailed representation. This representation, which is your 
blueprint for implementation, shows the relationship between all sites.

Configure the switch
The switch must be set up and configured at your site before you begin to 
implement Enterprise Networking. However, you must check the configuration 
and ensure that it is properly configured for Enterprise Networking.

The only additional switch configuration necessary for Enterprise Networking is 
the creation and setting of phantom DNs.
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Configure CallPilot
The network database contains information about your messaging network. 
When you configure CallPilot, you add information to the network database. 
You must add the following information to configure CallPilot:

■ general information about the message delivery configuration

■ detailed information about the local site: information about how the server 
handles messages and how the switch handles messages

■ detailed information about each remote site that communicates with the 
local site using Enterprise Networking

Validate the configuration
When you implement Enterprise Networking, you add configuration 
information about the messaging servers and switch locations to your network 
database.

Before you add this information, CallPilot validates the information to ensure 
that there are no conflicts.

Keep records
As you plan and implement Enterprise Networking, it is important to maintain 
detailed records about your site.

These records

■ provide a source of information for support personnel

■ share information about the site with other network administrators

Test the network
When you complete the configuration of Enterprise Networking, you perform a 
test suite. This test suite ensures that the configuration is correct and that 
Enterprise Networking is working properly.
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Backup the network
When you successfully complete the test suite, you perform a backup. The 
backup ensures that no configuration information is lost in the event of system 
failure.

See also
If you need additional information about the general implementation process, 
consult the Networking Planning Guide.

The Networking Planning Guide provides a more detailed discussion about the 
preliminary requirements, how to create network diagrams, and how to maintain 
a network history.
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Implementation in a complex messaging 
network

Introduction
Enterprise Networking is usually part of a complex messaging network that 
combines several CallPilot networking solutions.

Order of implementation
If you are implementing any other CallPilot networking solutions on your site, 
you will make the process easier to understand and manage by following the 
correct order of implementation.

The implementation of each networking solution builds upon earlier 
implementations. Information is often configured only once, and all subsequent 
networking solutions that are implemented use this configuration.

Recommended order
The recommended order for implementation is

■ Network Messaging Service (NMS), if the local site is an NMS site

■ Integrated AMIS Networking

■ Enterprise Networking

■ VPIM Networking

AMIS Networking
If your local site exchanges messages with both integrated and open sites, 
implement Integrated AMIS Networking only. Integrated AMIS Networking 
also contains the functionality of AMIS Networking.
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How Enterprise Networking works

In this section
About Enterprise Networking messages 66

About Enterprise Networking parameters 68

Understanding Enterprise Networking settings 72
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About Enterprise Networking messages

Introduction
You use Enterprise Networking to exchange messages among the sites in a 
messaging network. When you implement Enterprise Networking, you 
configure the system to handle these messages in a particular way.

An understanding of the basic components of a message makes the 
implementation process and configuration of CallPilot easier to understand.

Contents of an Enterprise Networking message
Every Enterprise Networking message contains two parts:

■ a message header

■ the message body

Message header
The message header transmits to the receiving site with  DTMF signals. The 
header contains the following information:

■ the sender’s address (which may include the site or location ID, mailbox 
number, and text name, depending on how the features are enabled)

■ each recipient’s address (site or location ID, mailbox number)

■ the type of message (regular, acknowledgment, or non-delivery 
notification)

■ the time and date when the message was sent

■ the message priority applied to the message (private, urgent, or 
acknowledgment)
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Message body
The recorded message and spoken name are played over the voice port of the 
sending site and are recorded by the receiving site. The recorded message 
contains the following information:

■ the voice portion of the message

■ any attachments

Note: The recorded message can optionally include a spoken name if this 
feature is enabled.

Message priorities
The sender can assign a message priority to Enterprise Networking messages. 
There are three message priorities:

■ economy

■ standard

■ urgent

One message priority, usually standard, is the default. Users must assign another 
message priority manually.

Configuration required for each message priority
The message priority that is assigned to a message determines how CallPilot 
handles the message.

When you implement Enterprise Networking, you configure the scheduling 
parameters that determine how messages with different message priority are 
handled.

In general, you send economy messages during lower long-distance toll charge 
periods. You send urgent messages quickly, with the emphasis on speed rather 
than cost.
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About Enterprise Networking parameters

Introduction
You set Enterprise Networking parameters during the implementation process. 
These parameters work with internal CallPilot settings to control how Enterprise 
Networking works.

Before you begin the implementation process, you must understand these 
parameters and decide on their settings.

Parameters set during implementation
CallPilot uses scheduling parameters to determine when to send messages to 
remote sites. CallPilot uses the following scheduling parameters:

■ batch threshold

■ stale times

■ economy message priority delivery start and stop times 

Parameter default values
CallPilot provides default settings for all scheduling parameters. The default 
values are based on typical requirements.

To ensure a quick implementation process, use these default values.

After your system is operational, monitor usage to determine if the default 
settings are serving the needs of your users. You can modify the scheduling 
parameters whenever users’ needs change.

For all default values, see “Defaults” on page 124.
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Batch threshold
The batch threshold is the number of standard and urgent messages that are held 
in queue waiting for delivery to a single remote site. When you send messages in 
batches, you make more efficient use of system resources. However, to ensure 
that messages awaiting delivery are not held too long in queue, the hold time 
overrides the batch threshold.

A message is held in a batch until either the batch threshold is exceeded or the 
hold time for standard or urgent messages is reached.

Batch thresholds only apply to standard and urgent messages.

Holding time
Holding time is the period of time that a message is held in queue before 
CallPilot attempts delivery. CallPilot holds a message in queue while it awaits 
the arrival of more messages for the same destination. This bulk sending makes 
more efficient use of the system.

However, to ensure that messages are always delivered in a timely fashion and 
do not wait too long for the arrival of additional messages, they are held for only 
a set period of time. This is the holding time.

CallPilot computes the holding time internally, based on the stale time.

Standard message holding time
The holding time for standard messages is one-third of the stale time for 
standard messages.

Urgent message holding time
The holding time for urgent messages is one-tenth of the stale time for urgent 
messages.
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Stale time
Stale time determines how long an undelivered message is held within the 
system before being returned to the sender with a non-delivery notification 
(NDN).

Stale times are set independently for economy, standard, and urgent messages. 
Typically, the stale time for an urgent message is shorter than that of a standard 
message because it may be critical for a user to know that an urgent message was 
not delivered.

The following examples are based on an Enterprise Networking site that uses the 
default values.

Example 1
Milo Feinstein sends a standard message. The message is held in the queue 
awaiting the arrival of three more messages. However, when the message has 
waited in queue for 40 minutes (the holding time for standard messages), the 
message is sent.

Example 2
Ronnie Prakesh and Philippe Dumont are users at the same site. Ronnie sends 
three standard messages for users at the remote site in Newmarket. Her 
messages are held in the queue. Philippe sends a message to a user at the same 
remote site. The batch threshold is reached, and all four messages are sent.

Example 3
Barney Gumbolski sends an urgent message. It is held in queue. No other 
messages for the same remote site arrive within six minutes (the holding time for 
urgent messages). Barney’s urgent message is sent.
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Economy delivery start and stop times
Economy messages receive different treament from standard and urgent 
messages. Economy messages are collected and are sent only during designated 
times, rather than held in queues.

The delivery start and stop times determine when the system sends economy 
messages to their destinations.

Economy messages often have a start time set to the beginning of lower-rate 
telephone services, and a stop time set to the resumption of regular rates.

Example
The following example is based on an Enterprise Networking site that uses the 
current default values.

At 8:00 a.m., Marge Sampson sends an economy message to a remote site. The 
message is held in queue until the economy delivery start time. The message is 
held in queue for a total of 16 hours. The economy message stale time is large 
enough to take this into account.
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Understanding Enterprise Networking settings

Introduction
In addition to the scheduling parameters, you must configure other settings when 
you implement Enterprise Networking.

These settings include

■ Enterprise site IDs

■ initiating and responding passwords

■ dialing plans

You must determining these settings in cooperation with the network 
administrators of all sites. The settings must be decided on before any site is 
implemented.

Enterprise site ID
If you implement Enterprise Networking on your local site, every remote site in 
your network database requires an Enterprise site ID.

All site IDs must be unique. Therefore, you need to coordinate with remote 
network administrators to ensure that this rule is observed before any site is 
implemented.

Initiating and responding passwords
Enterprise Networking uses passwords to send messages securely. When a 
message is sent from one site to another, the two sites trade two passwords, an 
initiating password and a responding password. Both passwords must match 
before a message is sent.

You establish passwords between pairs of sites. For this reason, you must 
contact the network administrator of each remote site in the messaging network 
and agree on the passwords that will be used.
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Example
The following diagram shows how passwords in network databases must match. 
Simple passwords are used for illustrative purposes.

The administrator in Bombay had to coordinate with the administrators in Tokyo 
and Tel Aviv to determine the passwords. With Tokyo, the passwords are “1234” 
and “5678.” With Tel Aviv, the passwords are “4321” and “8765.” This 
information is added to the network database in Bombay. 

Selecting passwords
Like all passwords, the initiating and responding passwords should be carefully 
thought out and secured. A password should be at least six characters long and 
combine both alphabetic and numeric characters within the ASCII set 3–126.

G100953.eps

Tel Aviv Network Database

Tokyo
Initiating password: 1234
Responding password: 5678

Bombay
Initiating password: 4321
Responding password: 8765

Bombay Network Database

Tokyo
Initiating password: 1234
Responding password: 5678

Tel Aviv
Initiating password: 4321
Responding password: 8765

Tokyo Network Database
Bombay
Initiating password: 1234
Responding password: 5678

Tel Aviv
Initiating password: 8877
Responding password: 9911

"4321" "8765"

"8877" "9911"

"1234" "5678"
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How Enterprise Networking handles 
messages

In this section
Overview 76

What the MTA does 78

What the ANA does 81

How a message is transferred 82
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Overview

Introduction
The scheduling parameters that you configure during the implementation of 
Enterprise Networking work in conjunction with internal CallPilot networking 
settings. These internal settings are controlled by

■ Message Transfer Agent (MTA)

■ Analog Networking Agent (ANA)

This brief overview provides a general understanding of how Enterprise 
Networking handles messages to help you interpret Alarm and Event reports.

MTA responsibilities
The MTA is responsible for the following services:

■ Queue outgoing network messages.

■ Determine when to begin sending messages to a remote system.

■ Receive incoming messages for delivery to local users.

■ Collect networking traffic operational measurements (OMs).

To ensure the timely handling of messages, the MTA wakes up CallPilot every 
minute.

When it wakes up, the MTA does the following:

■ initiates calls to remote sites

■ checks for stale messages

■ checks if any sites are in error status

MTA Monitor
The MTA Monitor continuously watches the performance of the MTA. The 
MTA Monitor provides detailed information and is useful for regular 
maintenance and troubleshooting. 

For complete information about the MTA Monitor and how it is used, consult the 
relevant section in System Support Tools.
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ANA responsibilities
The ANA sends messages to and from remote systems.

There is one ANA for every active port used during an Enterprise Networking 
session.

Main steps of message transfer
There are three main steps in the message transfer process:

■ The Message Transfer Agent determines if the message is ready for 
transfer.

■ The Analog Networking Agent completes a communication process, 
known as handshaking, with the receiving site.

■ The message, consisting of the message header and the message body, is 
transferred.
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What the MTA does

Introduction
The Message Transfer Agent (MTA) handles most aspects of message 
transmission for CallPilot.

 How MTA and ANA handle messages
The following diagram is a graphical representation of how CallPilot handles 
Enterprise Networking messages.
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The diagram shows the activity of both the MTA and the ANA in message 
handling.

G100969.eps
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As the diagram indicates, the MTA handles most of the processing. Every 
minute, a scheduler wakes the MTA. The MTA scans the message queue for 
each destination and checks the status of messages awaiting delivery. This scan 
determines if there are valid messages, according to the system parameter 
configuration. The MTA then determines if the valid messages are ready for 
delivery, according to the set system parameters.

Once the MTA determines that a transmission session is needed, it seeks a 
method of delivery from the call router. The ANA assumes responsibility for 
delivering the message.
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What the ANA does

Introduction
The Analog Networking Agent (ANA) works with the MTA to handle messages. 

How the ANA sets up calls
The ANA calls a remote site and delivers messages. 

CallPilot originates a network call to the receiving site using the connection 
directory number (DN) defined for that site. The switch places the call according 
to switch call-processing parameters.

If the call is successful, the call terminates on the networking connection DN at 
the receiving site.

If the call is not successful
If the call fails due to a busy or no-answer condition, CallPilot waits until the 
next wake-up interval before it attempts the call again. If three consecutive 
attempts fail, CallPilot places the receiving site into error status and an alarm is 
generated, depending on the nature of the problem.

CallPilot waits for one hour before it repeats the three-call attempt cycle.

When connection is established
When connection between the sending and receiving sites is established, ANA 
initiates a communication process known as handshaking.
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How a message is transferred

Introduction
After the ANA successfully establishes a message transfer session, the message 
transfer begins.

The message contains the message header and the recorded message.

How the ANA sets up calls
The ANA is responsible for calling a remote site and delivering messages and 
follows a complex routine. 

CallPilot originates a network call to the receiving site using the connection 
directory number (DN) defined for that site. The call is placed by the switch 
according to switch call-processing parameters.

If the call is successful, the call terminates on the networking connection DN at 
the receiving site.

If the call is not successful
If the call fails due to a busy or no-answer condition, CallPilot waits until the 
next wake-up interval before attempting the call again. If three attempts in a row 
fail, CallPilot places the receiving site into error status and an alarm is 
generated, depending on the nature of the problem.

CallPilot waits one hour before repeating the three-call attempt cycle.

When connection is established
When connection between the sending and receiving sites is established, ANA 
initiates a communication process known as handshaking.

Handshaking consists of the following steps:

1. The sending site identifies itself to the receiving site.

2. The receiving site verifies that the sending site is defined in the network 
database of the receiving site, and that the site ID and the message transfer 
protocol agree.
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If the information does not agree, the receiving site informs the sending site 
of the error and drops the call.

3. The sending site sends the initiating password and the receiving site ID to 
the receiving site.

4. The sending site also indicates that it will send a remote user text 
information if the necessary options are enabled on the site configuration 
for the receiving site.

5. The receiving site checks the site ID and password:

If the information is invalid, the receiving site informs the sending site that 
either the site ID or the password is incorrect, and drops the call.

If the information is valid, the receiving site proceeds to the following step.

6. The receiving site determines whether remote user or message text 
information will be received during this session.

7. The receiving site sends the responding password and indicates whether 
Names Across the Network information and a text subject header will be 
sent during this session.

8. The sending site checks the password:

If the password is invalid, the sending site sends an end-of-session message 
and drops the call.

If the password is valid, the sending site starts the message transfer to the 
receiving site.

Message transfer process
After the ANA successfully establishes a message transfer session, the message 
transfer begins.

The message contains the message header and the recorded message.
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The following table describes how messages are transferred:

The sending site The receiving site

sends the message information. The 
message contains the following:

■ time and date stamp

■ subject

■ message priority (private, urgent, 
or acknowledgment)

receives and intercepts the message 
information and creates the message.

sends the information about the 
sender. The information includes the 
following:

■ mailbox number, including site ID 
(and location ID if the remote site 
is using NMS)

receives and adds the sender to the 
message.

if the Remote User Add/Update 
option is selected, plays the spoken 
name.

■ records the spoken name.

■ adds or updates the remote user.

sends recipient information. The 
information includes the following:

■ mailbox number (including site 
and location ID).

■ recipient’s address as text, if the 
Receive Text Information option is 
selected.

receives and adds each recipient to the 
message.

plays the message body. records the message body and adds it to 
the message.

plays any attachments. records each attachment and adds it to 
the message.

indicates the end of the message. sends to the local MTA to deposit the 
message in each local recipient’s 
mailbox.
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repeats all of the above for each 
message.

repeats all of the above for each 
message.

The sending site The receiving site
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Gathering information

This chapter describes how to gather the information required to implement 
Enterprise Networking. This chapter provides a checklist for all information that 
is needed about the switch configuration.

This chapter also describes how to gather information about the other sites in the 
messaging network, and how to convert this information into a messaging 
network representation.

In this chapter 
Information required 89
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Information required

In this section
Overview 90 

Switch information 91

Information required from the switch 93

Evaluating the gathered information 96

Information from other sites 97

Messaging network representation 98
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Overview

Introduction
Before you begin to implement Enterprise Networking, gather the information 
that you require. You will speed up the implementation process if you have this 
information before you begin. When you analyze the information for 
inconsistencies and incompleteness, you ensure that potential problems are 
resolved ahead of time.

Required information
You must gather two types of information:

■ local site information, especially about the switch configuration 
information and dialing plan

■ messaging network information that is provided by all remote sites

Why gather information?
The gathered information is used to

■ identify the sites in the messaging network

■ identify how the sites relate to each other

■ identify the dialing plan used by each switch in the network

■ determine if the dialing plan on one or more switches in the network must 
be modified to support the networking solutions of CallPilot

■ create a messaging network representation

■ prepare for CallPilot configuration
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Switch information

Introduction
When you begin to implement of Enterprise Networking, the switch is already 
correctly installed and configured, and is operational for CallPilot.

This means that the switch is set up for dialing between the sites in the 
messaging network. The dialing plans that are configured on the switch for 
making telephone calls between sites are also used to exchange messages 
between sites.

You must check the configuration to make sure it is suitable for Enterprise 
Networking.

Gathering dialing plan information
You need the dialing plan information that is configured on the switch. You must 
know the dialing plan used in the messaging network and how all sites dial each 
other.

The easiest way to gather this information is to ask the switch technician or 
system administrator.

Gathering information directly from the switch
Gathering information directly from the switch is not recommended. The 
information that you require is found on several switch configuration files called 
overlays. Finding the information can be difficult and time-consuming. 

If you must gather the information from the switch, consult your switch 
documentation for the proper procedures and detailed descriptions of the 
information in each overlay.
Enterprise Networking Implementation and Administration Guide 91



Gathering information  Standard 1.0
Confirming settings
Usually, when the switch is configured, the switch technician addresses the 
impact of messaging on the switch.

However, to ensure that there will be no problems, you must confirm that the 
configuration suits the needs of Enterprise Networking and can handle your 
anticipated volume of traffic.

If you discover that changes are necessary, you must complete these changes 
before you proceed with the implementation of Enterprise Networking.
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Information required from the switch

Introduction
You must gather information from the switch. You must verify that the switch 
supports networking. You use some of the information, such as dialing plan 
information, to configure CallPilot.

Gather information from

■ the local prime switch location

■ the remote switch locations (prime and satellite)

Note: If the local site is an NMS site, you must also gather information from 
each satellite switch location. For instructions on how to gather this information, 
consult the NMS Implementation and Administration Guide.

Gather information about used features only
Most of the information that you gather from the switch is related to the dialing 
plan.

Gather information about a dialing plan only if a dialing plan is being used. Do 
not gather the information if the dialing plan is installed on the switch but is not 
currently being used.

Example: Your switch has both ESN and CDP installed. However, only ESN is 
used. Do not gather CDP information.
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Local prime switch location checklist
You need the following information from the switch configuration:

■ name or physical location of switch (useful to name the switch location on 
CallPilot)

■ dialing plan used:

● Electronic Switched Network (ESN)

● Coordinated Dialing Plan (CDP)

● hybrid dialing plan, combining ESN and CDP

● another dialing plan, such as public switched telephone network (PSTN)

■ if ESN or hybrid dialing plan is used:

● ESN access code

● ESN location codes:

- local switch location

- remote switch locations

● overlap of location codes with extension numbers

■ if CDP or hybrid dialing plan is used:

● CDP steering codes:

- local switch location

- remote switch location

● overlap of steering codes with extension numbers

■ confirmation that sufficient trunks are available for anticipated networking 
traffic

■ confirmation that restrictions are suitable for networking (for example, 
trunk group access restrictions [TGAR])

■ range of extension numbers used at the local site (for example, 7000–7999)

■ information about existing CDNs and phantom DNs that are defined on the 
switch
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Remote switch location information checklist
For each remote site in the messaging network, you need the following 
information about each switch location (prime and satellite):

■ name or physical location of switch (useful to name the switch location on 
CallPilot)

■ dialing plan used:

● Electronic Switched Network (ESN)

● Coordinated Dialing Plan (CDP)

● hybrid dialing plan, combining ESN and CDP

● another dialing plan, such as public switched telephone network

■ if ESN or hybrid dialing plan is used:

● ESN access code

● verify the ESN location codes:

- local switch location

- remote switch locations

● overlap of location codes with extension numbers

■ if CDP or hybrid dialing plan is used:

● CDP steering codes:

- local switch location

- remote switch location

● overlap of steering codes with extension numbers

■ range of extension numbers used at the local site (for example, 7000–7999)

■ confirmation that all extension numbers at this switch location can be 
dialed directly from the local switch

■ confirmation that all extension numbers at this switch location can be 
dialed in the same way
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Evaluating the gathered information

Introduction
When you have the dialing plan information from all switches in the messaging 
network, review the information to ensure that you do not have to make any 
changes to switch configurations.

Mandatory requirement
The dialing plans of all switches in the network must have a uniform, or 
standardized, dialing plan.

A uniform dialing plan means that users on all switches dial the same way to 
reach the same recipient. 

There is only one exception to this rule: ESN access codes can be different.

You need a uniform dialing plan to dial users on other switches within the 
messaging network and at public sites.

A uniform dialing plan offers the following benefits:

■ The network is easier to configure and maintain.

■ Future growth of the network is allowed.

Configuring dialing plan information
You need extensive switch programming experience to configure dialing plan 
information on a switch.

See also
You can find detailed information on dialing plan configuration in your switch 
documentation.

ATTENTION! If you determine that changes to the dialing plan 
configuration are necessary, ask a switch technician to 
confirm your conclusion and make the necessary changes.
96 CallPilot



October 2003 Gathering information 
Information from other sites

Introduction
Implementation of a networking solution is a coordinated effort. Many decisions 
must be made before implementation begins.

Gather the following information before you begin to implement Enterprise 
Networking:

■ site names

■ Enterprise site IDs

■ fully qualified domain names (FQDNs) of servers

■ the protocol used between the local site and all remote sites

■ the dialing plan used between the local site and all remote sites

■ connection DNs for each site that uses the AMIS protocol to exchange 
messages with the local site

If any remote sites are NMS sites, also gather the following information for each 
satellite switch location:

● switch location name

● switch type

● location ID

■ passwords—each site must decide on the initiating password and the 
responding password that is used with every other site
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Messaging network representation

Introduction
A messaging network representation provides a complete summary of your 
messaging network. This representation contains information about each of the 
sites and indicates the relationship between each pair of sites.

If sufficiently detailed, a messaging network representation is the primary source 
of information for implementing a messaging network.

The more detail you can supply, the easier you will find the implementation 
process.

A diagram is the most suitable form of representing most messaging networks. 
A spreadsheet is more appropriate for large messaging networks.

Definition: Messaging network diagram
A messaging network diagram is a graphical representation of your network. It 
includes the following types of information:

■ all sites in the network 

■ the protocols implemented at each site

■ the protocol used between sites

■ location codes and names

■ dialing plan information

Definition: Messaging network spreadsheet
A spreadsheet is more appropriate for representing a large messaging network. It 
provides the same information as the diagram.
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Benefits
There are many benefits to creating a representation of your messaging network. 
A representation

■ offers a clear view of how your network is connected

■ gathers all information required to implement a networking solution in one 
source

■ provides useful information when you plan future modifications

■ helps during the analysis of traffic issues

■ reveals areas where you can improve the network

■ provides support personnel with a concise, clear view of your network

Coordinating efforts
Administrators of other sites must provide much of the information for your 
network representation. For example, you need to know the site name and other 
information of every site.

Although each site administrator creates a representation, ideally one site 
administrator should create a final version to distribute to all sites. This ensures 
that the representation is comprehensive and that each site uses the same 
information for implementation.

Protecting the representation
Your network representation contains sensitive information. Keep it properly 
stored and protected as part of standard security procedures.

See also
For detailed instructions on how to create a network representation, as well as 
for several examples, consult the relevant section in the Networking Planning 
Guide.
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Configuring the switch for Enterprise 
Networking

This chapter describes how to configure the switch to implement Enterprise 
Networking. The chapter introduces the concepts that are necessary to 
understand the configuration process and provides detailed configuration 
procedures.

In this chapter
Configuring the switch 103
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Configuring the switch

In this section
Overview 104

SDN Table and Enterprise Networking 106

Adding and configuring SDNs 112

Phantom DNs and Enterprise Networking 116
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Overview

Introduction
The switch provides the call handling for CallPilot.

When you implement Enterprise Networking, the switch is already installed and 
configured, and is operational. It is ready for the implementation of Enterprise 
Networking.

There are two steps in the configuration process. On the server, you must set up 
inbound and outbound service directory numbers (SDNs) for Enterprise 
Networking. On the switch, you must set up phantom directory numbers (DNs).

Before you begin
Review the information that you gathered. Confirm the settings to ensure that 
they are correct. 

Before you begin to implement Enterprise Networking, complete and test any 
required changes to the switch settings.

How the switch views an Enterprise Networking call
The switch handles an Enterprise Networking message from the local site to a 
remote site like any other outbound telephone call.

The switch is already configured to handle outbound telephone calls. For this 
reason, Enterprise Networking is just an incremental implementation.

Enterprise Networking requirements
Like all services, however, Enterprise Networking needs a route that connects 
the messaging server and the switch.

Enterprise Networking requires only one additional configuration on the switch. 
A phantom DN is required for Enterprise Networking.
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See also
For detailed information about the switch, consult your switch documentation.

For information about how CallPilot works with the switch and how the switch 
must be configured, consult the relevant section in the Advanced Administration 
Guide.
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SDN Table and Enterprise Networking

Definition: SDN
A service directory number (SDN) is a number that enables a user to access a 
CallPilot service. Each SDN must be unique so that CallPilot can identify the 
requested service and play the appropriate prompts.

SDN Table
The system automatically creates the Service Directory Number Table during 
the initial installation of CallPilot. The SDN Table lists all SDNs and provides 
details about their settings.

CallPilot uses the SDN Table to map directory numbers (DNs) to services. The 
SDN Table lists both inbound and outbound SDNs.

Inbound and outbound SDNs
CallPilot requires both inbound and outbound SDNs. 

You must manually add an inbound SDN. An outbound SDN is created 
automatically if Enterprise Networking is installed. Both the inbound and the 
outbound SDNs require additional configuration.

Inbound SDNs
For most services, an inbound SDN is a number that a user enters to access a 
service. However, the Enterprise Networking inbound SDN is not a directly 
dialable number. A remote system dials this SDN when it delivers an Enterprise 
Networking message.

Outbound SDNs
CallPilot uses an outbound SDN to make the requested service available. An 
outbound SDN consists of the word OUTBOUND and a number.
106 CallPilot



October 2003 Configuring the switch for Enterprise Networking 
Example: SDN Table
The following illustration shows an SDN Table that lists both inbound and 
outbound Enterprise SDNs.

If another service shares the inbound Enterprise SDN, that service appears in the 
SDN Table. 

When you review an SDN Table, the only way you know if an SDN is shared is 
by the description. For this reason, the description of the SDN should mention 
that it is shared with the inbound Enterprise Networking SDN.
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SDN numbers
An SDN must be unique, but it is not randomly selected. CallPilot uses SDNs to 
map numbers to services. There are also important relationships between the 
SDN and other numbers used by the system.

Relationship of SDN to other numbers
The CallPilot SDN setup echoes the DN settings on the switch.

An important relationship exists between the inbound SDN and the local system 
access number (SAN), and the phantom DN on the switch. For example,

■ The inbound Enterprise Networking SDN = 7400.

■ The Enterprise Networking local SAN = 1-416-597-7400.

■ The phantom DN for Enterprise Networking = 7400.

The Enterprise Networking inbound SDN on CallPilot must correspond to the 
Enterprise Networking phantom DN on the Meridian switch. Before you create 
an SDN for Enterprise Networking, confirm the phantom DN on the switch.

To view the phantom DN setting, consult the gathered switch information.

Phantom DNs
There are two ways to create an Enterprise Networking phantom DN on the 
switch:

■ Define a new phantom DN for Enterprise Networking.

■ Share an existing phantom DN of specific services.

Media type
To process a call, Enterprise Networking needs access to a channel. A channel 
provides a connection between the switch and the Digital Signal Processor 
(DSP) cards on the CallPilot server.

CallPilot supports three channel types. Each type corresponds to different 
media:

■ voice

■ fax

■ speech recognition
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Enterprise Networking can use all three channel types. However, a voice channel 
is recommended. By default, CallPilot automatically assigns a voice port to 
Enterprise Networking.

Minimum and maximum channels
You must determine the channel resources for both inbound and outbound 
Enterprise Networking SDNs.

Every service, including Enterprise Networking, requires channel resources to 
process calls. Channel resources are the number of channels that Enterprise 
Networking has available. Channel resources are set as minimum and maximum 
values. The minimum value is the number of channels that is always reserved for 
the exclusive use of the service.

This setting is important because if you incorrectly allocate channel resources, 
users may experience delays in reaching requested services.

Example: Channel allocation
Your system has 96 available channels. You decide to dedicate a minimum of 5 
channels and a maximum of 30 channels to Enterprise Networking. If the system 
handles only five Enterprise Networking calls each day, more appropriate 
allocation is a minimum of 1 channel and maximum of 3 channels.

Examples: How to use inbound and outbound Enterprise Networking 
SDNs

The following examples describe a network that consists of two sites, and show 
how to use the inbound and outbound Enterprise Networking SDNs to provide 
services. 

In these examples, it is important to distinguish between messages sent by users 
and calls made by the CallPilot system itself.
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Example 1: Shared SDN
This example describes how to use a shared inbound SDN.

Howard wants to send a message to Joy in Chicago. He enters 6060, which is 
directed to the SDN for Integrated Voice/Fax. The request is directed to 
CallPilot, which routes it to the outbound Enterprise Networking SDN. The 
system in Philadelphia calls the remote SAN of the system in Chicago, 
64447080, and the two systems complete the required handshaking before the 
message is transferred. 

The Voice Menu SDN, which is shared with the inbound Enterprise Networking 
SDN, receives the message. The Voice Menu SDN is set to act when it receives 
an AMIS initiator tone. The message is directed to Joy’s mailbox.

G100993.eps

SDN Service

6060 Integrate Voice/Fax
6070 Announcement
6080 Inbound Enterprise

Outbound Enterprise 10

SDN Service
7070 Integrated Voice/Fax
7075 Express Messaging
7079 Fax on Demand
7080 Voice menu
        (acts on Enterprise initiator tone)

Outbound Enterprise 10

Joy Howard

MAS
Server

MAS
Server6444xxxx

6338xxxx

SAN = 64447080

SAN = 63386080
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Example 2: Unique SDN
This example describes how to use an inbound Enterprise Networking SDN that 
is not shared.

Joy wants to send a message to Howard in Philadelphia. She enters 7070, which 
is directed to the SDN for Integrated Voice/Fax. The request is directed to 
CallPilot, which routes it to the outbound Enterprise Networking SDN. The 
system in Chicago calls the remote SAN of the system in Philadelphia, 
63386080, and the two systems complete the required handshaking before the 
message is transferred. The inbound Enterprise Networking SDN receives the 
message and directs it to Howard’s mailbox. 

See also
For detailed information on SDNs and SDN Tables, consult the Advanced 
Administration Guide.
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Adding and configuring SDNs

Enterprise Networking SDNs
Enterprise Networking requires an outbound SDN and an inbound SDN.

Outbound SDN
An outbound SDN is created automatically when you install Enterprise 
Networking. You can modify the default channel resource allocation.

Inbound SDN
An inbound SDN is not created automatically. There are two ways to set up an 
inbound SDN:

■ Create a new inbound SDN.

■ Share an inbound SDN with certain other services.

The choice depends on your administrative requirements.

Services that can share an inbound SDN with Enterprise Networking
Enterprise Networking can share the inbound SDN of the following services:

■ Announcement Service

■ AMIS Networking

■ Fax Information Service

■ Voice Menu

■ Time of Day Controller

■ Thru-Dial

Do this If the primary concern is

Create new SDNs. Operational Measurement reports must be 
precise for each service.

Share SDNs with other 
services.

a shortage of DNs exists or is likely to exist.
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Getting there  Nortel SMI > Meridian Application Server > System Configuration 
> Service Administration > Service Directory Number

To add and configure a new inbound SDN

1 From the SDN Table, select New from the File menu.

Result: The New Inbound Service Directory Number Properties dialog box 
appears.

2 On the General tab, enter the SDN number in the Service DN box.

Note: This number must correspond to a CDN or phantom DN on the 
switch.

3 Select an application from the Application Name list.

Result: The corresponding application ID appears above the application 
name in the Application ID box.

4 Select the type of channel required by the service in the Media Type list.
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5 If you want to reserve a minimum number of channels for the service, enter 
the number in the Minimum Channels box.

6 Do one of the following:

● Select the Use Default Maximum box. This is the recommended option.

● Enter the maximum number of channels that a service can use at one 
time in the Maximum Channels box.

Note: The maximum number of channels cannot exceed the total number 
of channels available on the server. If you enter a number larger than the 
total number of channels, a warning box appears asking you to change the 
number.

7 Enter any comments in the Comments box.

8 Click Save to add the SDN to the SDN Table.

To share an existing inbound SDN with Enterprise Networking

1 Select an existing inbound SDN that can be shared with Enterprise 
Networking from the SDN Table.

2 On the File menu, click New.

Result: The New Inbound Service Directory Number Properties dialog box 
appears.

3 On the General tab, in the Comments box, insert a brief comment that the 
SDN is shared with Enterprise Networking. 

Tip: This comment appears in the final column of the SDN Table and is the 
easiest way to determine which SDN is shared with Enterprise Networking.
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4 Click the Session Profile tab.

Result: The Session Profile tab appears.

5 Select Act on AMIS/Enterprise networking initiator tone. You select this 
option only for the SDN that is being shared with the inbound Enterprise 
SDN.

6 Click Save to add the shared SDN to the SDN Table.
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Phantom DNs and Enterprise Networking

Switch setting required for Enterprise Networking
SDNs on the server have a direct correspondence to phantom directory numbers 
(DNs) on the switch.

If you create a new SDN for Enterprise Networking, you need a phantom DN for 
Enterprise Networking. If you share an existing SDN for Enterprise Networking 
with an existing service, Enterprise Networking also shares the phantom DN of 
that service.

Enterprise Networking uses DNs
To access a CallPilot service, a user enters a unique dialable number. The 
dialable number is known as a directory number (DN). There are different types 
of DNs, including extension numbers and telephone numbers. 

The switch uses the DN to route the call to the requested service.

Example 
A user enters a DN, 7505, to access Remote Notification.

Switch and DNs
All DNs that you use to access a service correspond to a setting on the switch. To 
handle calls in sequence of arrival, the system places calls in a queue, depending 
on the call type.

The switch has as many as three queues, called controlled directory number 
(CDN) queues, which you use for the following types of services:

■ Voice Messaging

■ Fax Call Answering

■ Speech Recognition Messaging

Each CDN queue is associated with a dialable number known as the CDN. A 
user can dial the service directly by entering the CDN.
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Example
The CDN of Voice Messaging is 7400. A user can dial 7400 to reach Voice 
Messaging. The call is placed into the queue.

Phantom DNs
While there are queues for three types of services, CallPilot users usually have 
many individual services available within each type. These services are also 
dialable.

To offer more than three services, the switch uses phantom DNs.

A phantom DN is a unique dialable number that is routed to one of the CDN 
queues.

A phantom DN is not a randomly selected number. There is a direct 
correspondence between the local system access number (SAN) for Enterprise 
Networking and the phantom DN.

If Enterprise Networking shares an existing phantom DN, check that the 
phantom DN is configured to forward messages to the correct CDN queue. For 
Enterprise Networking, the phantom DN should forward messages to the Voice 
Messaging CDN queue.

Example
The phantom DN for Express Messaging is 7401. A user dials 7401 and expects 
to reach the requested service. However, the switch routes the phantom DN to 
the appropriate CDN queue (in this case, Voice Messaging) before the service is 
provided.

Enterprise Networking phantom DN
Enterprise Networking requires a phantom DN for incoming messages.

However, unlike other phantom DNs, it is not dialed by a local user when 
addressing an Enterprise Networking site. The system uses this number when an 
Enterprise Networking message must be sent to a remote site.

Users at remote sites also use the phantom DN when they make a call to a local 
system.
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Ways to create the phantom DN
There are two ways to create a phantom DN for Enterprise Networking:

■ Use a unique phantom DN. Most switch technicians create additional 
phantom DNs for use by services like Enterprise Networking.

■ Share an existing phantom DN. If Enterprise Networking shares a service 
directory number (SDN) with another service, it also shares the phantom 
DN of the service.

See also
For a detailed description of how the switch is configured for CallPilot, consult 
the relevant section in the Advanced Administration Guide.
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Configuring CallPilot for Enterprise 
Networking

This chapter describes how to configure CallPilot to implement Enterprise 
Networking.

The chapter introduces the concepts that are necessary to understand the 
configuration process and provides detailed descriptions of configuration 
procedures.

In this chapter
Configuring CallPilot 121
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Configuring CallPilot

In this section
Overview 122

Configuration summary 123

Message delivery parameters—Enterprise tab 126

Configuring the message delivery parameters 129

Creating a loopback mailbox 131
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Overview

Configuring CallPilot
The implementation of Enterprise Networking requires additional configuration 
of CallPilot. This configuration determines how Enterprise Networking 
exchanges messages with other sites in the messaging network.

To configure CallPilot for Enterprise Networking, you must

■ confirm CallPilot administration settings

■ define Enterprise Networking information

■ create a loopback mailbox

Before you begin
Complete the switch configuration before you configure CallPilot.

ATTENTION! You must perform each step in the configuration process 
in the order presented.
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Configuration summary

Introduction
The Enterprise Networking message delivery configuration determines how 
Enterprise Networking handles messages.

You provide this information on the Enterprise tab of the Message Delivery 
Configuration dialog box.

Required information
When you complete the Enterprise tab, the following are required:

■ enabled outgoing and incoming Enterprise Networking

■ batch threshold

■ economy delivery times

■ stale times

See also
A general overview of how Enterprise Networking uses this information is 
provided in Chapter 2, “Getting started”.
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Defaults
CallPilot provides default settings for the message delivery configuration. The 
default values are based on typical requirements.

To simplify the process of implementing Enterprise Networking, use the default 
values. After your system is operational, monitor usage and performance to 
determine if the default settings are sufficient. You can change the settings 
whenever users’ needs change.

Parameter Current default

Batch threshold 4 messages

Stale time for standard messages 2 hours

Holding time for standard messages 40 minutes (calculated internally, based 
on stale time settings)

Stale time for urgent messages 60 minutes

Holding time for urgent messages 6 minutes (calculated internally, based on 
stale time setting)

Stale time for economy messages 6 hours

Delivery start time for economy 
messages

6:00 p.m.

Delivery stop time for economy 
messages

11:00 p.m.
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Suggested process
Read through this section on how to configure Enterprise Networking 
information. The settings that you select determine how efficiently your system 
handles Enterprise Networking messages.

Ideally, know how you are going to complete the required information before 
you begin the configuration.

Before you begin
You must properly configure the inbound and outbound SDNs for Enterprise 
Networking before you configure Enterprise Networking.
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Message delivery parameters—Enterprise tab

Introduction
To implement Enterprise Networking you must set the parameters that CallPilot 
uses to deliver messages.

These parameters are set on the Message Delivery Configuration dialog box 
Enterprise tab. 

Outgoing and incoming Enterprise networking
If Enterprise Networking is installed on your system, the following options are 
enabled by default:

■ Outgoing Enterprise Networking

■ Incoming Enterprise Networking
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These boxes restrict the use of Enterprise Networking.

If you do not want local users to send outbound Enterprise Networking 
messages, clear the Outgoing Enterprise Networking option.

If you do not want local users to receive inbound Enterprise Networking 
messages, clear the Incoming Enterprise Networking option.

To completely disable Enterprise Networking, clear both options.

Batch Threshold
When you batch messages, you send messages that are intended for a single 
destination in a group. This method makes more efficient use of the system than 
if you send each message separately.

The batch threshold defines the maximum number of messages intended for a 
single destination that can be queued before CallPilot begins to send the 
messages.

The batch threshold applies only to standard and urgent message types.

The batch threshold overrides the CallPilot holding times.

Economy delivery start and stop times
An economy message is a message that a user tags for economy delivery.

Economy messages are treated differently from standard and urgent messages. 
Economy messages are not held in queues. Instead, they are collected through 
the day and are sent only during designated times. The delivery start and stop 
times determine when the system begins to send economy messages to their 
destinations.

Economy messages often have a start time set to the beginning of lower-rate 
telephone services, and a stop time set to the resumption of regular rates.

Example
If the telephone rate is lower between 11:00 p.m. and 6:00 a.m., set the start time 
at 11:00 p.m. and the stop time at 5:55 a.m.
Enterprise Networking Implementation and Administration Guide 127



Configuring CallPilot for Enterprise Networking  Standard 1.0
Stale times
Stale time is the period of time that CallPilot holds an undelivered message 
before it considers the message undeliverable and returns it to the sender with a 
non-delivery notification (NDN). In the period before a message is considered 
stale, CallPilot makes repeated attempts at delivery.

Stale time is expressed as a time period, such as 10 minutes or 5 hours.

Separate stale times are set for economy, standard, and urgent messages. The 
stale time for urgent messages should be the shortest time, because it is critical 
to know if an urgent message is not delivered.

Stale time settings affect holding times
CallPilot uses stale time settings to calculate holding times. 

The holding time is the period of time that a message is held in queue before an 
attempt is made to send it.

Urgent messages
For urgent messages, the holding time is one-third of the stale time.

For example, if you set the urgent stale time to 30 minutes, the urgent message 
holding time is automatically set to 10 minutes. 

Standard messages
For standard messages, the holding time is one-tenth of the stale time.

For example, if you set the standard stale time to 5 hours, the standard message 
holding time is automatically set to 30 minutes.

Holding times interact with the batch threshold
The interaction of the holding time and the batch threshold ensures that 
messages are delivered in a timely and efficient manner. A message is sent when 
the batch threshold is reached or when the holding time is reached—whichever 
is sooner.
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Configuring the message delivery parameters

Introduction
You must configure the parameters that determine how your system handles 
messages.

You configure these parameters on the Message Delivery Configuration dialog 
Enterprise tab.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > Message 
Delivery Configuration > Enterprise tab

To configure Enterprise Networking parameters

1 To enable your site to send outgoing Enterprise Networking messages, 
ensure the Outgoing Enterprise Networking check box is selected.

2 To enable your site to receive incoming Enterprise Networking messages, 
ensure the Incoming Enterprise Networking check box is selected.

3 Enter the batch threshold in the Collect (number of) messages before 
sending (Batch Threshold) box.

4 Enter the economy delivery start and start times in the Start Time and Stop 
Time boxes.

5 Enter the stale times for each message type:

● Standard

● Urgent

● Economy

6 Click Save.

Result: The information is validated and entered into the network 
database.
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What’s next?
After configuring CallPilot for Enterprise Networking, you must complete one 
basic administrative activity. Every site in the messaging network requires a 
loopback mailbox.

Although it is not mandatory to complete this administrative task at this time, it 
is recommended.
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Creating a loopback mailbox

Introduction
When you implement Enterprise Networking, create a loopback mailbox. 
Although it is not mandatory to create the loopback mailbox at this time, 
completing this task now will save you considerable time later.

Definition: Loopback mailbox
A loopback mailbox is a mailbox that is created at each site in a messaging 
network. You use a loopback mailbox to test the capability of a site.

To test that a site can send a message to a remote site, a message is sent to the 
loopback mailbox. The loopback mailbox automatically returns the message to 
the sender.

Remote sites use your loopback mailbox to test their systems. You use the 
loopback mailboxes of each remote site to test your system.

Since each site requires a loopback mailbox, create one now so that the testing 
can proceed without interruption.

Loopback mailbox requirements
A loopback mailbox is not a real mailbox because it does not collect messages. 
It bounces messages back to the sender. However, the loopback mailbox number 
must be unique and cannot conflict with any other mailbox number.
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Getting there  Nortel SMI > Meridian Application Server > User Administration > 
Messaging Administration Properties > Mailboxes tab

To create a loopback mailbox

1 In the Networking Loopback mailbox box, enter the mailbox number.

2 Click Save.

Result: The information is validated and saved to the database.

Announce the loopback mailbox
Remote network administrators test their implementation by sending an 
Enterprise Networking message to your loopback mailbox. Announce the 
loopback mailbox number to all remote sites.

Similarly, gather the loopback mailbox numbers from the network 
administrators of all other remote sites.

Using the loopback mailbox
A remote administrator addresses a test message to a loopback mailbox using 
the protocol and dialing plans specified for use between the two sites.

For example, you create a loopback mailbox, 9999, on your site. Enterprise 
Networking is used between a remote site and your site. The ESN dialing plan is 
used, and the ESN prefix to address your site from the remote site is 3555. 
Therefore, to address your loopback mailbox, the remote network administrator 
enters 35559999.
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Adding sites to Enterprise 
Networking

This chapter describes how to define the sites in the messaging network that use 
Enterprise Networking to exchange messages.

This chapter describes how to configure the local messaging server and prime 
switch location. It also explains how to add and configure remote messaging 
servers and switch locations.

In this chapter
About the messaging network 135

Configuring the local site 141

Adding and configuring a remote site 163
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About the messaging network

In this section
Overview 136

Configuration and other networking solutions 137
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Overview

Introduction
A CallPilot messaging network consists of a local site and one or more remote 
sites.

All sites in your private messaging network with which your local site 
exchanges messages must appear in the Messaging Network Configuration tree 
view. If a remote site is part of the messaging network, but the local site does not 
exchange messages with that remote site, you do not add it to the tree view.

To implement Enterprise Networking, you must configure the local site and add 
and configure all remote sites that will transfer messages with the local site 
using Enterprise Networking.

See also
Sites are configured in the Messaging Network Configuration tree view. For an 
overview of how to work with the tree view, consult the relevant section in the 
Networking Planning Guide.

Before you begin
You should have already configured the Message Delivery Configuration dialog 
box for Enterprise Networking.

If your local site is an NMS site, NMS should be configured and tested.

Your messaging network representation should be complete and available. This 
representation provides a blueprint for the implementation process.

ATTENTION! It is strongly recommended that you complete each step 
in the configuration process in the order presented.
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Configuration and other networking solutions

Introduction
If any other CallPilot networking solution is implemented on your local system, 
much of local messaging server and the local switch location configuration is 
already complete.

Configuring the local messaging server and switch location
If another networking solution is implemented on the local site, the local 
messaging server and prime switch location configuration is almost entirely 
complete. You must only confirm the settings and enter the information that is 
specifically required to implement Enterprise Networking.

For example, if Integrated AMIS Networking is already implemented on your 
system, most of the required information is already entered into the network 
database.

NMS local site
If your local site is an NMS site, implement and test NMS before you begin to 
implement Enterprise Networking.

If NMS is installed, the NMS satellite switch locations for the local site appear 
in the Messaging Network Configuration tree view below the local prime switch 
location.

Remote sites
If another CallPilot networking solution is implemented on your system, remote 
sites may already be added and configured. These sites appear in the Messaging 
Network Configuration tree view. These sites exchange messages with the local 
site using the other networking solution.

When you implement Enterprise Networking, you must add and configure the 
remote sites that will communicate with your local site using Enterprise 
Networking. These sites appear in the tree view only as you add them.
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Example: Implementing Enterprise Networking
In this example, you are the network administrator of Site 6. Working with the 
network administrators of the other sites in your messaging network, you have 
created a diagram of your messaging network. Note that many details are 
removed from this network diagram for clarity.

Your local site has the following networking solutions: Integrated AMIS 
Networking, AMIS Networking (available because Integrated AMIS 
Networking is installed), NMS, and Enterprise Networking.

Since you are following the recommended order of implementation, you have 
completed the following for Site 6:

■ NMS is implemented and tested.

■ Integrated AMIS Networking (and AMIS Networking) is implemented and 
tested.

The local messaging server and switch locations are configured.

To implement Integrated AMIS Networking, you add the following remote sites 
to your network database because you use the AMIS protocol to send and 
receive messages with them:

■ Site 3

■ Site 4

■ Site 5—satellite switches are also added
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You are now ready to begin implementing Enterprise Networking. After 
configuring the message delivery parameters, complete the configuration of the 
local messaging server and add the sites that use Enterprise Networking to the 
network database.

In this example, you must add Site 1 and Site 2 to your network database, 
because they are the sites that use Enterprise Networking to communicate with 
your site, Site 6.
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Configuring the local site

In this section
Overview 142

Configuring the local messaging server 144

Configuring the local prime switch location 150

Configuring ESN information 156

Configuring CDP information 160
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Overview

Introduction
When CallPilot is initially installed on your system, a local messaging server 
and local switch location are automatically added to the Messaging Network 
Configuration tree view.

Local messaging server name
By default, both the local messaging server and the prime switch location are 
assigned the name “Untitled.” Assign new names to the local messaging server 
and the prime switch location during configuration.

The local site receives its name from the name assigned to the local messaging 
server.

Configuration
You must configure the local messaging server. To configure the messaging 
server, you save general information, such as name and description, to the 
network database.

The local messaging server is configured on the General tab of the Local Server 
Properties dialog box.

SMTP/VPIM Server FQDN
The SMTP/VPIM Networking Server FQDN box is enabled only if VPIM 
Networking is installed on your system. It is configured during the 
implementation of VPIM Networking.

However, if the box is enabled on the General tab, you must enter a placeholder 
in the box or you will be unable to close the tab and save the information to the 
network database.

While implementing Enterprise Networking, enter a placeholder in this box. You 
will replace this placeholder with the correct server FQDN when you implement 
VPIM Networking.
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Configuring the local server if another messaging solution is 
implemented

If you have implemented another CallPilot networking solution on your local 
system, you have already completed most local messaging server configuration.

For example, if Integrated AMIS Networking is already implemented, the Name, 
Description, and Send Messages to all other Server fields are already completed.

In this case, check the current configuration and complete additional options that 
are specific to Enterprise Networking and would not have been completed 
during the previous implementation.
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Configuring the local messaging server

Introduction
You must configure the local messaging server to implement Enterprise 
Networking.

If another networking solution is implemented, most of the information is 
already completed. You must only check the information and add the 
information required for Enterprise Networking.

The local messaging server is configured on the Local Server Properties—
General tab. 
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Name
By default, both the local messaging server and the prime switch location are 
assigned the name “Untitled.” Assign new names during configuration.

The messaging server is usually given a name that corresponds to its geographic 
location.

Local site name
The name given to the local messaging server becomes the name of the local 
site.

Server type
The local messaging server is always CallPilot.

Description
Provide a brief description of the messaging server or implementation notes, 
such as when the server was configured or who completed the configuration, in 
the Description.

Send Messages to all other Servers
The Send Messages to all other Servers check box determines if the local site 
can send messages to integrated remote sites in the messaging network.

This check box is selected by default and is cleared only under exceptional 
circumstances.

When cleared, the local messaging server does not send messages to any 
integrated remote site using any protocol. Messages can still be sent to open 
remote sites.

When to clear this option
This option lets you quickly disable messaging from your local site. Clear this 
check box in emergency situations.

Restricting the sending of messages
Clearing the Send Messages to all other Servers check box is a quick way to 
disable the system.
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You restrict the sending of messages to each remote site separately.

To prohibit the local messaging server from sending messages to a particular 
remote site, clear the Send Messages to this Server check box on the Remote 
Messaging Server Properties—General tab.

For example, your messaging network has six sites and you do not want to send 
messages to one of these sites. You select the Send Messages to all other Servers 
option while you configure the local messaging server. You clear the Send 
Messages to this Server option while you configure the remote server to which 
you do not want to send messages.

Note: When the Send Messages to all other Servers box is cleared, users can still 
send messages to open sites using the VPIM and AMIS protocols.

Add/Update Remote Users on this Server
The Names Across the Network feature is available with Enterprise Networking 
only.

The Add/Update Remote Users on this Server check box enables the Names 
Across the Network feature to work with Enterprise Networking.

This box controls your local server. You must coordinate with the network 
administrator of each remote site with which you want to enable Names Across 
the Network. You can use Names Across the Network only with remote sites that 
use Enterprise Networking and have the Send Remote User Info feature enabled.

Additional information
The Names Across the Network feature is not the only way to add remote users 
to your local network database. You can also add remote users manually with 
User Administration.

For a detailed discussion of remote users and Names Across the Network, 
consult the Networking Planning Guide.
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Enterprise Site ID
To implement Enterprise Networking, you must assign an Enterprise site ID to 
your local messaging server.

The site ID, combined with the location ID, identifies the local site to remote 
sites in the messaging network.

The site ID is one of the pieces of information included in a message header.

When Enterprise Networking is implemented on any site in a messaging 
network, every site that exchanges Enterprise Networking messages with it must 
have a site ID.

Receive Message Text Info
The local messaging server can receive message subject headers in the messages 
sent by all remote sites that are enabled to send message subject headers.

The message subject header is available to desktop users.

In most environments, the Receive Message Text Info check box is selected. 
However, if the local site incurs long-distance toll charges when receiving 
messages, you may want to clear this option because messages that include 
message subject headers take longer to send.

Server FQDN
The Server FQDN box is enabled only if VPIM Networking is installed on your 
local site. The server FQDN is entered when you implement VPIM Networking.

However, the Local Server Properties—General tab cannot be closed and the 
information cannot be saved to the network database unless the Server FQDN 
box contains some information. When you implement Enterprise Networking, if 
you do not know the server FQDN, enter a placeholder in the box. If you know 
the server FQDN, enter it.

For example, enter “FQDN_goes_here”. A clearly marked placeholder reminds 
you to complete the box when you implement VPIM Networking.
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration

To configure the local messaging server

1 In the Messaging Network Configuration tree view, select the local 
messaging server.

2 On the File menu, click Open.

Result: The Messaging Network Configuration—Local Server—General 
tab appears.

3 To change the name of the local server, enter a new name in the Name box.

Tip: The name given to the local messaging server is also the name of the 
local site.

Note: The server type is always CallPilot and cannot be changed.

4 In the Description box, enter details about the local messaging server.

5 To enable the local messaging server to send messages to the remote sites 
in your messaging network, select the Send Messages to all other Servers 
check box.

Attention: If this check box is not selected, messages cannot be sent to 
remote sites. This check box is cleared only in unusual circumstances. To 
clear the check box, you are prompted to confirm your decision.

6 To enable the Names Across the Network feature, select the Add/Update 
Remote Users on this Server box.

7 In the Enterprise Site ID box, enter a unique ID number for the local 
messaging server.

8 To enable the local messaging server to receive message subject headers 
with Enterprise Networking messages from all remote sites that are willing 
to send these headers, select the Receive Message Text Info check box.

9 If the Server FQDN box is enabled, enter a valid placeholder or, if available, 
the FQDN of the local server.

Note: If you enter a placeholder, you replace it when you implement VPIM 
Networking.

10 Click Save.

Result: The information is validated and saved to the network database.
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What’s next?
After you configure the local messaging server, configure the local prime switch 
location.
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Configuring the local prime switch location

Introduction
You must configure the local prime switch location to implement Enterprise 
Networking.

If any other networking solution is implemented
If another networking solution is implemented on the local site, the local switch 
location is already configured.

Check the current configuration information. Make any necessary modifications.

If NMS is implemented
If NMS is installed on the local site, the local prime switch location is already 
configured.

All satellite switch locations attached to the local prime switch location are also 
already configured.

Check the current configuration information. Make any necessary modifications.

If no other networking solution is installed locally
If no other networking solution is implemented on the local site, complete the 
General tab. Complete the ESN tab or the CDP tab, or both, depending on the 
dialing plan used on your local switch location.
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Where the prime switch location is configured
The local prime switch location is configured on the Prime Switch Location 
Properties dialog box, which has four tabs:

■ General

■ ESN

■ CDP

■ SMTP/VPIM

General tab
Complete the General tab no matter what dialing plan is used on your local site.

ESN tab
Complete the ESN tab if the local site uses the ESN or a hybrid dialing plan.

CDP tab
Complete the CDP tab if the local site uses the CDP or a hybrid dialing plan.

SMTP/VPIM tab
The SMTP/VPIM tab is enabled only if VPIM Networking is installed on your 
local switch location.

You complete the SMTP/VPIM tab when you implement VPIM Networking on 
your local site, not during the implementation of Enterprise Networking.
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Message Delivery Configuration

To open the Prime Switch Location Properties dialog box

1 In the Messaging Network Configuration tree view, select the local prime 
switch location.

2 On the File menu, click Open.

Result: The Messaging Network Configuration—Prime Location 
Properties—General tab appears.

. 
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Name
Each switch location must be assigned a name that is unique within the 
messaging network. Usually, this name is the same as the name of the messaging 
server. This ensures that the identity of the switch location within the network is 
immediately apparent. A geographic name is common.

For example, if a messaging server is named “Moscow,” the prime switch 
location is usually also named “Moscow.”

By default, the local prime switch location is given the name “Untitled.” This 
name must be changed.

Description
The Description box is useful for short notes, reminders, or comments about the 
switch location.

You might find it useful to specify your switch model, the date of the switch 
configuration, or contact information for the switch technician.

Enterprise Location ID
The Enterprise Location ID box is not enabled for the prime switch location.

Note: The location ID for a prime switch location is always 0 and cannot be 
changed.

Spoken Name Recorded
If your local site is not an NMS site, the Spoken Name Recorded box is not 
enabled.

If your site is an NMS site, the Spoken Name Recorded check box was 
configured during the NMS implementation.

Dialing plan information
Detailed information about the dialing plan used on the local prime switch 
location is required when configuring the local prime switch location.
Enterprise Networking Implementation and Administration Guide 153



Adding sites to Enterprise Networking  Standard 1.0
Dialing plans for dialing to this location
You must specify which of the following dialing plans is used to dial to the local 
switch location:

■ ESN

■ CDP

■ hybrid, which combines ESN and CDP

■ another dialing plan (such as PSTN)

When you configure the local prime switch location, you specify the dialing plan 
that is used to dial to the local site. 

Note: If you use ESN anywhere in the messaging network, ESN must be 
selected because the local site needs an ESN access code.

Mailbox specifications
The following boxes are dynamically enabled and disabled depending on the 
dialing plan you have specified for the prime switch location:

■ Mailbox addressing follows dialing plan

■ Mailbox prefixes

Mailbox addressing follows dialing plan
The Mailbox addressing follows dialing plan box is enabled only if NMS is 
installed on the local messaging server. If NMS is implemented, this check box 
should be properly configured already.

Mailbox prefixes
A mailbox prefix is a leading string of digits that uniquely identifies a mailbox 
number as belonging to a particular site.

If the local site does not have NMS installed, you never need mailbox prefixes 
for the local prime switch location.

If the local site does have NMS installed, the mailbox prefix or prefixes should 
be properly configured already.
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To configure the local prime switch location

1 To change the name of the local prime switch location, enter a name in the 
Name box.

2 In the Description box, enter details about the local prime switch location.

3 In the Enterprise Location ID box, enter the location ID number of the local 
prime switch location.

Note: The Enterprise location ID is always 0 and cannot be changed.

4 Confirm the status of the Spoken Name Recorded box.

Note: This box is enabled only if NMS is installed and was completed 
during the implementation of NMS.

5 Specify the dialing plan used to dial the local prime switch location. Select 
the

● ESN check box if ESN is used

● CDP check box if CDP is used

● ESN and CDP check boxes if a hybrid dialing plan is used

Note: Leave both check boxes clear if you use another dialing plan, such as 
PSTN.

6 Determine whether you must complete another tab. If not, click Save to 
close the dialog box. 

7 Select another tab to continue the configuration.

What’s next?

If the local site uses an ESN, CDP, or hybrid dialing plan
After you complete the General tab, you must complete the ESN tab, or the CDP 
tab, or both tabs, depending on the dialing plan used.

If the local site uses another dialing plan
If your local site uses another dialing plan, such as PSTN, you have completed 
the configuration of your local prime switch location.
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Configuring ESN information

Introduction
If the local prime switch location uses either an ESN dialing plan or a hybrid 
dialing plan, you must complete the ESN tab.

You provide the ESN access codes and ESN location codes. These are combined 
to create the ESN prefix.

See also
For a description of the ESN dialing plan and how it works, consult the 
Networking Planning Guide.

. 
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ESN Access Code used by this location
The ESN access code is used to access ESN routing in the same way that an 
access code, such as 9, is used to dial out to the public network from a private 
network.

Typically, all switches in a messaging network use the same ESN access code.

ESN Location Codes
An ESN location code is a routing prefix that identifies a location within a 
network. It is usually three digits long, but can be up to ten digits long.

You must also indicate the number of digits in the ESN location code that 
overlap the mailbox number.

The ESN Location Codes list contains all ESN location codes currently assigned 
and indicates the overlap between the ESN location code and the mailbox 
directory numbers.

ESN location codes can be added, modified, or deleted at any time. The ESN 
location codes must always match the dialing plan configuration on the switch.

ESN location code capacity
The maximum number of ESN location codes for a switch location is 30.

ESN location code overlap
When you enter the dialing plan information for the local site, calculate the 
number of digits in the ESN prefix that overlap the digits in the local extension.

If there is overlap between the rightmost digit or digits of the location code and 
the leftmost digit or digits of the extension number, enter the amount of overlap.

The following table provides two examples of ESN location code overlap.

Access 
code

Location 
code

Extension 
number

Number dialed by users at 
other sites Overlap

6 338 8300 63388300 0

6 338 8300 6338300 1
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration > Local Prime 
Switch Location > ESN tab

To configure the ESN information

1 Enter the ESN access code.

2 To add a new location code, click the Add New button.

Result: The New ESN Location Code Properties dialog box appears.

3 In the Location Code box, enter the location code.

4 In the Overlap box, enter the number of digits in the mailbox number that 
overlap the location code.

5 Click Save.

Result: The location code and overlap are validated and appear in the ESN 
Location Codes list box on the ESN tab.

6 Repeat steps 3–5 for each ESN location code that you require.

7 When you have finished configuring the ESN information, determine if you 
must configure CDP information. 

● If yes, click the CDP tab. 

● If no, click Save to validate the ESN information and save it to the 
database.
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What’s next?
If your local prime switch location uses the hybrid dialing plan, click the CDP 
tab to continue configuring the local prime switch location.
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Configuring CDP information

Introduction
If the local switch location uses either a CDP dialing plan or a hybrid dialing 
plan, complete the CDP tab.

You must provide the CDP steering codes.

See also
For a general description of the CDP dialing plan and how it works, consult the 
Networking Planning Guide.
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CDP Steering Codes
A CDP steering code is a site prefix that identifies the local site within the 
network. Therefore, a CDP prefix must be unique for all switches in the 
messaging network.

CDP steering codes are determined by the switch technician. 

The CDP steering codes defined on the switch are entered on CallPilot because 
the system must be able to identify the steering code in the mailbox number to 
determine the site.

The CDP Steering Codes list box contains all CDP steering codes currently 
assigned to the switch location. The list box also indicates the overlap between 
the CDP steering codes and the mailbox directory numbers.

CDP steering codes can be added, modified, or deleted.

CDP steering code capacity
The maximum number of CDP steering codes for a switch location is 500.

CDP steering code overlap
When you enter the dialing plan information, you must calculate the number of 
digits in the CDP steering code that overlap the digits of the local extension.

If there is overlap between the rightmost digit or digits of the steering code and 
the leftmost digit or digits of the extension number, enter the amount of overlap.

Normally, the steering code overlaps with the first few digits of a local extension 
number.

The following table provides three examples of CDP steering code overlap.

Steering 
code

Extension 
number

Number dialed by users at other 
sites

Amount of 
overlap

22 22345 2222345 0

22 22345 222345 1

22 22345 22345 2
Enterprise Networking Implementation and Administration Guide 161



Adding sites to Enterprise Networking  Standard 1.0
Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration > Local Prime 
Switch Location > CDP tab

. 

To configure the CDP information

1 Click the Add New button.

Result: The New CDP Steering Code Properties dialog box appears.

2 In the Steering Code box, enter the steering code.

3 In the Overlap box, enter the number of digits in the mailbox number that 
overlap the steering code.

4 Click Save.

Result: The steering code and overlap are validated and appear in the 
CDP Steering Codes list box on the CDP tab.

5 Repeat steps 1–4 for each CDP steering code required.

6 When you have added all necessary CDP steering codes, click Save.

Result: The information is validated and saved to the network database.

What’s next?
You have completed the configuration of the local site and are ready to begin 
adding and configuring remote sites.
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Adding and configuring a remote site

In this section
Overview 164

Configuring a remote messaging server 166

Configuring a remote prime switch location 175

Configuring a remote satellite switch location 187

Recording a spoken name 191

Importing a spoken name 193

Checking the configuration of other remote sites 195

Non-CallPilot remote sites 197

Meridian Mail remote sites 199
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Overview

Introduction
When you implement Enterprise Networking, you add to the Messaging 
Network Configuration tree view all the remote sites that use Enterprise 
Networking to exchange messages with the local site.

Every remote site added to the tree view must be configured.

Information required
The information that you enter when you configure a remote site reflects the 
information that is configured for that site in its own local network database. For 
example, you enter the name of that site and its Enterprise site ID. You must get 
this information from the remote network administrator.

However, configuring a remote site involves more than simply copying the 
information provided by the remote site. You also enter information that reflects 
how your local site will communicate with that remote site. For example, for 
each remote site, you decide whether your local site sends messages to this 
particular remote server.

Main steps
There are three main steps to adding a remote site to your local network 
database. For each remote site, you must add and configure

■ the remote messaging server

■ the remote prime switch location

■ the remote satellite switch locations, if the remote site is an NMS site

Network representation
Much of the information that you must provide while configuring a remote 
messaging server is contained in the network diagram or spreadsheet.
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Correcting information about remote sites already added to the 
network database

If another messaging network solution is already implemented on your local site, 
such as Integrated AMIS Networking, check the information for the remote 
messaging servers that you added to your local network database during that 
configuration.

For example, when you added remote sites to your network database during the 
installation of Integrated AMIS Networking, you added the remote sites that use 
the AMIS protocol to send messages to and receive messages from your local 
site. When configuring these remote sites, the validation process forced you to 
enter an Enterprise site ID for the remote site to save the configuration to your 
network database.

You must check the Enterprise site IDs that you entered for these sites to ensure 
that they are valid and correct. If you entered a random number as a placeholder, 
change them to actual site ID numbers.
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Configuring a remote messaging server

Introduction
When you initially install CallPilot on your system, your local site, which 
consists of a local messaging server and a local prime switch location, is 
automatically added to the Messaging Network Configuration tree view.

However, you must manually add each remote site that exchanges messages with 
the local site using Integrated AMIS Networking into the Messaging Network 
Configuration tree view. You must configure both the remote messaging server 
and the remote prime switch location.

You must complete the following tabs for each remote messaging server:

■ Remote Messaging Server Properties—General tab

■ Remote Messaging Server Properties—Connection Information tab

Remote servers and other messaging solutions
If you have implemented another CallPilot networking solution on your system, 
you have already added remote sites to the Messaging Network Configuration 
tree view.

The process of adding a remote site is essentially the same regardless of the 
networking solution being implemented. However, when you add remote sites 
during the implementation of Enterprise Networking there are important 
differences.
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Remote Messaging Server Properties—General tab
The Remote Messaging Server Properties—General tab contains detailed 
information about the remote messaging server and defines how the local site 
and the remote site exchange messages.

. 

Name
You should assign the remote messaging server the same name that was assigned 
to it by its local network administrator. This correspondence in naming sites 
makes the network easier to administer and maintain because all network 
administrators use the same names for the same sites.

For example, if a remote site calls itself “Connecticut,” you should name it 
“Connecticut” when you add it to the Messaging Network Configuration tree 
view.
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Server type
The remote messaging server can be any of the following types:

■ CallPilot

■ Meridian Mail Net Gateway (MMNG)

■ Norstar Voice Mail (Norstar)

■ Meridian Mail

■ Other

Description
Provide a brief description of the remote messaging server or useful notes, such 
as when the messaging server was configured or who completed the 
configuration. 

Send Messages to this Server
The Send Messages to this Server check box interacts with the Send Messages to 
all other Servers check box on the Local Messaging Server Properties—General 
tab.

When you configured the local messaging server, you decided if you wanted the 
local messaging server to send messages to all remote messaging servers. This 
option is selected by default and is cleared only under exceptional circumstances 
only. 

However, you can still stop the delivery of messages to specific remote 
messaging servers. The Send Messages to this Server check box enables you to 
block the delivery of messages from your local messaging server to a particular 
remote site.
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Example
In the following diagram, Helsinki is configured to deliver messages to all other 
sites. However, the network database record for Paris and for Cairo specifies that 
messages are not sent to these remote sites. Messages are sent to both Lammi 
and Korso-Rekola. Therefore, while the potential exists for sending messages to 
all remote sites, only two remote sites receive messages.

Send local user information to this Server
The Send local user information to this Server check box determines if the 
Names Across the Network feature is used with this remote site. If enabled, this 
feature was configured during the implementation of Enterprise Networking.
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Enterprise Site ID
The Enterprise Site ID box is enabled only if Enterprise Networking is installed 
on the local site. 

All remote sites connected to a site that has Enterprise Networking installed 
must have an Enterprise site ID, regardless of the actual protocol used with the 
site.

Send Message Text Info to this Server
This check box applies only to remote sites that use Enterprise Networking to 
exchange messages with the local site. If enabled, message text information is 
sent to the remote site.

Server FQDN
If VPIM Networking is installed on your local site, the VPIM Networking 
Server FQDN box is enabled.

However, since your local site transfers messages with this remote site using 
Enterprise Networking, the Fully Qualified Domain Name (FQDN) of the 
remote server is not required.
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Remote Messaging Server—Connections tab
The configuration of a remote messaging server continues on the Connections 
tab.

Network protocol
When implementing Enterprise Networking, you must specify that the protocol 
used by the local site to exchange messages with this remote site is Enterprise.

To use a particular protocol, both sites must have the same networking solution 
installed and implemented.

If a remote site is not configured to use the same protocol as the local site, the 
following occurs when the local site attempts to send a message:

■ The message is not delivered.

■ An error message is generated.

■ The remote site is put into error status on the local system.
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Enterprise Networking Connection DNs
When CallPilot initiates a call to a remote site, it uses the networking connection 
DN that is specified for the remote site in your network database.

Up to three DNs can be defined. DN1 is mandatory. DN2 and DN3 are optional.

The first Enterprise Networking connection DN is the Enterprise Networking 
SDN for the remote site, as defined in the SDN table of the remote site. If 
Enterprise Networking is sharing an SDN with another service, such as AMIS 
Networking, then the networking connection DN is the DN that accepts such 
network calls.

You must contact the administrator of the remote site for the connection DN.

The connection is entered in a format that is dialable from the local site.

The system always uses DN1 to call the remote site unless it encounters 
problems. If the system does encounter a problem, it attempts to contact the 
remote site using DN2, then DN3. In general, the DNs are ordered from least 
expensive to most expensive connections. For example, DN1 could be a private 
number and DN3 could be a public telephone number.

Network passwords
Unique passwords are used between each pair of sites in the messaging network. 
They are used to secure the messaging network and the integrity of the 
messages. Two passwords are used to verify that any two sites may 
communicate with each other:

■ initiating password

■ responding password

The passwords on your site must match the site you are calling or from which 
you are receiving messages.
172 CallPilot



October 2003 Adding sites to Enterprise Networking 
Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration 

To configure a remote messaging server

1 In the Messaging Network Configuration tree view, select Remote Server 
Maintenance.

2 On the File menu, click New > Messaging Server.

Result: The Remote Messaging Server Properties—General tab appears.

3 On the General tab, in the Name box, enter the name of the remote 
messaging server.

4 Select the server type from the Server type box.

5 In the Description box, enter details about the remote messaging server.

6 To enable the local messaging server to send messages to this remote 
messaging server, ensure that the Send Messages to this Server box is 
selected.

7 Enter the unique Enterprise site ID number of the remote messaging server 
or a valid placeholder.

8 To continue configuring the remote messaging server, click the 
Connections tab.

Result: The Connections tab appears.
. 

9 From the Network protocol list, select Enterprise.

Result: The Connection DNs boxes become enabled.

10 In the DN1 box, enter the connection DN.

Note: DN1 is mandatory. At least one DN must be the system access 
number of the remote site.

11 Repeat for each connection DN.

Note: If you are defining more than one connection DN, list them in order of 
cost. Connection DN1 should be the least expensive means of contacting 
the remote site.

12 Enter the Initiating and Responding Enterprise Passwords.
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13 Click Save.

Result: The information is validated and entered into the network 
database.

What’s next?
After you add information about the remote messaging server into your local 
network database, you must also add information about the remote prime switch 
location.
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Configuring a remote prime switch location

Introduction
When you added a remote messaging server to the Message Network 
Configuration tree view, a corresponding prime switch location was added.

A remote prime switch location must be configured. This process is almost 
identical to configuring the local prime switch location.

Remote Prime Switch Location dialog box
The remote prime switch location is configured on the Remote Prime Switch 
Location Properties dialog box, which has four tabs:

■ General

■ ESN

■ CDP

■ SMTP/VPIM

General tab
Completing the General tab is mandatory.

ESN tab
Complete the ESN tab if an ESN or a hybrid dialing plan is used with this 
remote site.

CDP tab
Complete the CDP tab if a CDP or a hybrid dialing plan is used with this remote 
site.

SMTP/VPIM tab
Because your local site is not using VPIM Networking to transfer messages with 
this remote site, do not complete the SMTP/VPIM tab.
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Remote Prime Switch Location Properties—General tab
. 

Name
Assign a unique name to each switch location. The name should correspond to 
the switch location to make the location easy to identify. A street or city name is 
a good choice.

The remote switch location is automatically given the name of the remote server 
that was added to the Messaging Network Configuration tree view. This name 
can be changed.

Description
Enter short notes or comments about the remote switch location in this box.
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Enterprise Location ID
The Enterprise Location ID box is enabled only if Enterprise Networking is 
implemented on the local site.

A location ID is required for all remote sites if Enterprise Networking is 
installed locally, even if another protocol is used to exchange messages with this 
site.

The location ID of the prime switch location is set to 0 by default and cannot be 
changed.

Spoken Name Recorded
When local users compose a message to this remote site or use the playback 
feature to determine the sender of a message, they hear a message that identifies 
the sender. The content of the message depends on whether a spoken name for 
that remote site is recorded.

If a spoken name is recorded, voice mail users hear the location name followed 
by the local mailbox directory number.

Example: “Dallas, Mailbox 2346”

Spoken name not recorded
If a spoken name is not recorded, local users hear a full mailbox address that 
does not identify the sender’s site by name.

For example, for an ESN switch location, users hear the ESN location prefix 
followed by the local mailbox directory number.

Example: “Mailbox 6444 2346”

When a spoken name is not desirable
You may decide that you do not want local users to hear a spoken name for a 
particular remote site. For example, if CDP is used for messaging with this 
remote site and the mailbox numbers follow the dialing plan, you may decide 
that a recorded spoken name is unnecessary. In this case, do not record or import 
a spoken name.

Ways to add a spoken name recording
There are two ways to add a spoken name recording: record a spoken name 
directly by clicking the Record button, or import a prerecorded message.
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Dialing and addressing
Provide general information on the dialing plan used by the switch.

Several of the boxes are enabled or disabled, depending on the selections made. 
The dialing plan boxes have complex interactions. Complete all enabled boxes.

Dialing plans for dialing to this location
You must specify which dialing plan is used to dial this remote switch location 
from the local switch location. There are four possible dialing plans:

■ ESN

■ CDP

■ hybrid, which combines ESN and CDP

■ another (such as PSTN)

Mailbox addressing follows dialing plan
When a mailbox follows the dialing plan, a user dials and addresses a message to 
a recipient in the same way. There are two ways to achieve this correspondence:

■ A user’s mailbox number and extension number are the same.

■ The addressing plan and the dialing plan are the same.

If either situation is true, select the Mailbox addressing follows dialing plan 
check box.

Clear this option if users at the site do not dial and address recipients in the same 
way.

Example: If the local ESN prefix is 6222 and the local mailbox is 1234, remote 
users can dial the local user with the number 62221234, which is the ESN prefix 
and the mailbox number combined.

Example: If the CDP steering code is 22 and the local mailbox is 1234, remote 
users can dial the local user with the number 221234, which is the steering code 
and the mailbox number combined.
178 CallPilot



October 2003 Adding sites to Enterprise Networking 
Mailbox prefixes
Mailbox prefixes are used by local users to address users at a remote site if 
mailboxes at the remote site do not follow the dialing plan.

A mailbox prefix must be provided if the mailbox does not follow the dialing 
plan or if another dialing plan, such as PSTN, is used.

A mailbox prefix does not have to overlap with local mailbox numbers. Two 
mailbox prefixes can be entered. Either prefix can be used to address any 
mailbox at the local site. Normally, however, only one prefix is required.

Usually, the mailbox prefix is a shortcut. A mailbox prefix can be any number as 
long as it does not conflict with other network data.

A mailbox prefix can also be the entire telephone number of the site, including 
country code, city/area code, and exchange.

Example: If the mailbox prefix is 22 and the mailbox number of a local user is 
6565, users at other switches address the local user by dialing 226565.

Dialing prefix
A dialing plan is needed if the local site uses another dialing plan, such as PSTN, 
and users at your local site use a dialing prefix to reach users at this remote site.

Usually, if the Dialing prefix box is enabled, you enter the prefix.

In a few cases, a dialing prefix is not needed. For example, if the mailbox 
number, without the mailbox prefix, can be dialed directly, a dialing prefix is not 
needed. This situation is rare because most systems use some sort of access 
code.
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration 

To configure the remote prime switch location

1 In the Messaging Network Configuration tree view, select the remote prime 
switch location.

2 On the File menu, select Properties.

Result: The Remote Prime Switch Location Properties dialog box appears.

3 On the General tab, in the Name box, enter the name of the remote prime 
switch location.

4 In the Description box, enter details about the switch location.

Note: The Enterprise Location ID is always set to 0 for remote prime switch 
locations and cannot be changed.

5 If needed, click Record to record a spoken name for the site, or click Import 
to import a prerecorded spoken name.

Note: For instructions on how to record a spoken name, see “Recording a 
spoken name” on page 191.

For instructions on how to import a spoken name, see “Importing a spoken 
name” on page 193.

6 Specify the dialing plan used to dial the remote site. Select the

■ ESN check box if ESN is used

■ CDP check box if CDP is used

■ ESN and CDP check boxes if a hybrid dialing plan is used

Note: Leave both check boxes clear if you use another dialing plan, such as 
PSTN.

7 Indicate if mailbox addressing follows the dialing plan.

8 If necessary, enter the mailbox prefix or prefixes.

9 If necessary, enter the dialing prefix.
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ESN information
If the remote prime switch location uses an ESN or a hybrid dialing plan, 
complete the ESN tab.

The procedure for configuring the ESN information for a remote prime switch is 
identical to the procedure used for the local prime switch location.

Note: You must provide the ESN access code used at the remote site. Do not 
enter the access code used locally.

For a review of the ESN access codes, ESN location codes, and overlap, consult 
“Configuring ESN information” on page 156.
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To configure the ESN information

1 Open Message Delivery Configuration > Remote Prime Switch Location > 
ESN tab.

2 Enter the ESN access code.
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3 To add a new location code, click the Add New button.

Result: The New ESN Location Code Properties dialog box appears.

4 In the Location Code box, enter the location code.

5 In the Overlap box, enter the number of digits in the mailbox number that 
overlap the location code.

6 Click Save.

Result: The location code and overlap are validated and appear in the ESN 
Location Codes box on the ESN tab.

7 Repeat steps 3–6 for each ESN location code required.

8 When you have finished configuring the ESN information, determine if you 
must configure CDP information. If yes, click the CDP tab. If no, click Save.

What’s next?
If your remote prime switch location uses the hybrid dialing plan, click the CDP 
tab to continue the configuration of the local prime switch location.

If the local prime switch location uses only the ESN dialing plan, click Save to 
validate the configuration information and save it to the network database.

. 
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CDP information
If a CDP dialing plan or a hybrid dialing plan is used to connect the local site to 
the remote site, complete the CDP tab.

Configuring the CDP information for a remote prime switch location is identical 
to configuring the local prime switch location.

For a review of the CDP steering codes and overlap, consult “Configuring CDP 
information” on page 160.
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To configure the CDP information:

1 Open Message Delivery Configuration > Remote Prime Switch Location > 
CDP tab.

2 Click the Add New button.
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Result: The New CDP Steering Code Properties dialog box appears. 

3 In the Steering Code box, enter the steering code.

4 In the Overlap box, enter the number of digits in the mailbox number that 
overlap the steering code.

5 Click Save.

Result: The steering code and overlap are validated and appear in the 
CDP Steering Codes box on the CDP tab.

6 Repeat steps 2–5 for each CDP steering code required.

7 When you have added all necessary CDP steering codes, click Save.

Result: The information is validated and added to the network database, 
and you return to the Messaging Network Configuration tree view.

What’s next?
You have completed the configuration of the remote prime switch location.
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Configuring a remote satellite switch location

Introduction
If a remote site is an NMS site, you must add and configure each of its satellite 
switch locations. This information is saved to the local network database.

Although a prime switch location is added automatically when a remote site is 
added to the Messaging Network Configuration tree view, you must manually 
add each satellite switch location of a remote NMS site.

Capacity
An NMS site can have up to 59 satellite switch locations.

Organization
When you add a satellite switch location, this location appears in the Messaging 
Network Configuration tree view. Satellite switch locations are listed 
alphabetically below the prime switch location.

Where to configure a satellite switch location
To configure a satellite switch location, complete the General tab of the Network 
Messaging Configuration property page.

You must also complete the tabs that correspond to the dialing plan used by the 
local site.

ESN tab
Complete the ESN tab if you use an ESN or a hybrid dialing plan.

CDP tab
Complete the CDP tab if you use a CDP or a hybrid dialing plan.
Enterprise Networking Implementation and Administration Guide 187



Adding sites to Enterprise Networking  Standard 1.0
Spoken Name Recorded
When local users compose a message to a remote satellite switch location or use 
the playback feature to hear who sent a message, the name of the switch location 
is played. 

If a spoken name is not recorded, local users hear the full DN, such as “Mailbox 
64441234.” If a recording of the spoken name is available, local users hear the 
switch location name followed by the mailbox number, such as “Milan 1234.” 
You can either record a message using the telephone or import a prerecorded 
WAV file.

When a recording of the spoken name is available, Yes appears in the Spoken 
Name Recorded box.

If you do not want your local users to hear the name of this satellite switch 
location when composing messages or using playback, do not record a message. 
For example, if you are using CDP to transfer messages to the site and mailbox 
numbers follow the dialing plan, you may feel that a spoken name is 
unnecessary.

Dialing plan interaction
The dialing plan boxes are dynamically enabled or disabled depending on the 
choices made. Complete all enabled fields. 

See also
Configuring a satellite switch location for a remote site is  identical to 
configuring a remote prime switch location for a remote site. 

For a review, consult “Configuring a remote prime switch location” on page 
175.
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Getting there  Nortel SMI > Meridian Application Server > CallPilot> Networking 
> Messaging Network Configuration

To add a remote satellite switch location

1 On the Messaging Network Configuration tree view, highlight the remote 
messaging server.

2 On the File menu, select New > Switch location.

Result: The Satellite Switch Location Properties dialog box appears.

3 To add the satellite switch location to the remote site, configure the satellite 
switch location.

4 In the Satellite Switch Location Properties dialog box, complete the General 
tab.

5 To record a spoken name, click Record.
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To import a prerecorded spoken name, click Import.

Note: For detailed instructions on how to record or import spoken names, 
consult “Recording a spoken name” on page 191, or “Importing a spoken 
name” on page 193.

6 Complete the ESN tab and the CDP tab as required.

7 Click Save.

Result: The information is validated and the satellite switch location is 
added to the remote site.

8 Repeat steps 1–4 for each satellite switch location required.

9 When all satellite switch locations are added, click Save to save them to the 
Messaging Network Configuration tree view.
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Recording a spoken name

Introduction
You can create a recording of the name of a switch location. A recorded name is 
heard by a local user whenever an address is played back. A recorded name for a 
site is played if a user does not have a personal recorded name.

Local switch location
If your local site is not an NMS site, a spoken name is not required for the local 
site.

If your local site is an NMS site, you can decide if you want to record a spoken 
name. For example, if the NMS site uses CDP, you may decide a spoken name is 
not necessary.

Remote switch location
A spoken name should be available for every remote site in your Message 
Delivery Configuration tree view.

The recording is played when local users compose messages to the remote site.

Importing a spoken name
If you do not want to record your own voice using the telephone, you can import 
a prerecorded WAV file. See “Importing a spoken name” on page 193.

Before you begin
A telephone serves as the microphone. Therefore, if you want to record a spoken 
name, a telephone must be available.
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration

To record a spoken name

1 In the Messaging Network Configuration tree view, select the switch 
location of the site for which you want to record a spoken name.

2 On the File menu, select Open.

Result: The Switch Location Properties dialog box appears.

3 On the General tab, click Record.

Result: The Specify Phoneset dialog box appears.

4 Enter the telephone number of the telephone to be used as a microphone 
and click Dial.

Result: The telephone rings and the Voice Recorder dialog box appears.

5 Answer the telephone.

6 In the Voice Recorder dialog box, click Record.

7 Speak the name of the site into the telephone.

8 Click Stop.

9 To review the recording, click Play.

10 If you are satisfied with the recording, click Done.
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Importing a spoken name

Introduction
You can import a prerecorded file of the name of a switch location. The 
recording is heard by a local user whenever an address is played back. A 
recording for a site is played if a user does not have a personal spoken name.

Local switch location
If your local site is not an NMS site, a spoken name is not required for the local 
site.

If your local site is an NMS site, you can decide if you want to import a spoken 
name. For example, if the NMS site uses CDP, you may decide a spoken name is 
not necessary.

Remote switch location
A spoken name should be available for every remote site in your Message 
Delivery Configuration tree view.

The recording is played when local users compose messages to the remote site.

Instead of importing a spoken name
If you do not want to import a prerecorded spoken name, you can record your 
own voice message using the telephone.

Before you begin
A prerecorded WAV file must be available. Check the quality of the recording 
before importing the file.
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration

To import a prerecorded file

1 In the Messaging Network Configuration tree view, select the switch 
location of the site for which you want to import a prerecorded file.

2 On the File menu, select Open.

Result: The Switch Location Properties dialog box appears.

3 On the General tab, click Import.

Result: The Open dialog box appears.

4 Select the WAV file, and click Open.

Result: The file is imported.

5 Close the Open dialog box.
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Checking the configuration of other remote 
sites

Introduction
If you implemented another networking solution before you implemented 
Enterprise Networking, you may not have completed all required information.

For example, if you implemented Integrated AMIS Networking, you may have 
added an Enterprise site ID. You should have entered the correct site ID shown 
in your network diagram. However, if you used a placeholder instead of the real 
site ID, you must correct it.

Note: You are not changing the protocol used for these remote sites. You are 
only defining information that Enterprise Networking uses to identify a site.

Recommended procedure
It is recommended that you check the Enterprise site ID for all remote 
messaging servers added during the implementation of another networking 
solution. Check the remote switch location ID number also.

To check the Enterprise Site ID

1 Open the Remote Server Properties dialog box.

2 On the General tab, check the Enterprise site ID.

3 If the site ID is correct, click Cancel.

If the site ID is incorrect, replace the ID and click Save.

4 Repeat steps 1–3 for each remote site added during the implementation of 
another networking solution.
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To check the Enterprise Location ID

1 Open the Remote Prime Switch Location Properties dialog box.

2 On the General tab, check the Enterprise location ID.

3 If the location ID is correct, click Cancel.

If the location ID is incorrect, replace the ID and click Save.

4 Repeat steps 1–3 for each remote site added during the implementation of 
another networking solution.
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Non-CallPilot remote sites

Introduction
Enterprise Networking can exchange messages between a CallPilot system and 
the following non-CallPilot remote systems:

■ a  Meridian Mail (Release 8 and later) system

■ a Norstar Voice Mail (Release 3 and later) system

Coordination
If a remote site is a non-CallPilot system, you must coordinate with the network 
administrator of that remote site to ensure that the systems are properly 
configured. You must share the standard information that is required between 
any sites in a messaging network.

Example
The two sites must coordinate dialing plans and ensure that there are no conflicts 
in the configuration information.

Adding and configuring the remote site
Adding a non-CallPilot remote site to the local network database is exactly the 
same as adding a CallPilot remote site.

To configure the non-CallPilot remote site, you require no special information. 
You must only specify the server type on the Remote Messaging Server dialog 
box. The rest of the configuration is the same as the configuration of a CallPilot 
remote site.

Server type
Specify the server type of a non-CallPilot system on the Messaging Network 
Configuration—Remote Server Properties—General tab.
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Instructions for the remote administrator
For both Meridian Mail and Norstar Voice Mail systems, there are no special 
considerations that must be communicated to the remote network administrator.

You add the CallPilot site to the remote network database like any other remote 
site. No special configuration is required.
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Meridian Mail remote sites

Introduction
CallPilot can exchange Enterprise Networking messages with Meridian Mail 
(Release 8 and higher).

If a remote site is a Meridian Mail system, you must coordinate with the network 
administrator of that site to ensure that the systems are properly configured.

The coordination involves standard information that is required between any 
sites in a messaging network (for example, site names and dialing plan 
information).

Instructions for the remote Meridian Mail administrator
The CallPilot site is added to the network database like any other site.

Special considerations
CallPilot does not support network broadcast. If network broadcast messages are 
sent from the Meridian Mail site, they are rejected.

For Meridian Mail (Release 11 and higher), the Meridian Mail administrator can 
selectively disable the network broadcast for selective sites. Network broadcast 
should be disabled for remote CallPilot sites.

Testing
The Meridian Mail administrator can run an additional test, the Enterprise 
diagnostic test, to determine if Enterprise Networking is performing properly. 
This test is not available for network administrators at CallPilot sites.
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Norstar Voice Mail remote sites

Introduction
Enterprise Networking can exchange messages between a CallPilot system and a 
Norstar Voice Mail (Release 3 and later) system.

Instructions for the remote Norstar Voice Mail administrator
Add the CallPilot site to the network database like any other site. There are no 
special considerations that must be communicated to the network administrator.
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c h a p t e r  7

Testing and backing up Enterprise 
Networking

This chapter describes how to test the Enterprise Networking configuration. The 
test suite determines if Enterprise Networking works properly both locally and 
with remote sites.

This chapter also describes how to create a backup of your system to ensure that 
the correct configuration is not lost due to system failure.

In this chapter 
Tests and backups 203
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Tests and backups

In this section
Enterprise Networking test suite 204

Call routing test 206

Local SDN test 207

Quick SDN test 209

Loopback test 210

End-to-end test 212

Backing up Enterprise Networking 215
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Enterprise Networking test suite

Introduction
After you configure CallPilot for Enterprise Networking, test the system.

The Enterprise Networking test suite tests every aspect of the system. If any test 
fails, resolve the problem and retry the test before you continue.

Note: These tests are not intended to validate the Enterprise compliance of a 
third-party system. The tests assume that any system that you communicate with 
is Enterprise-compliant.

Test suite
The Enterprise Networking test suite consists of five tests. Two tests are local 
site tests, which verify that your local configuration is correct. Three tests are 
coordinated site tests, which verify that everything works properly at your site 
and at every remote site.

The following table lists the local site tests and describes their purpose:

This local site test determines if

call routing test ■ the local system can make outbound 
calls to other sites in the network.

■ the local system cannot make 
outbound calls to restricted sites on the 
network.

local SDNs test ■ Digital Signal Processing (DSP) cards 
are working properly and SDNs are 
defined correctly.
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The following table lists the coordinated site tests and describes their purpose:

Coordination
While you can perform local site tests independently, you must work with the 
network administrators at each remote site to perform the coordinated site tests.

In some instances, the remote administrator must make preparations before you 
can conduct the test. For example, to complete the loopback test, the remote 
network administrator must create a loopback mailbox.

If a test is unsuccessful and you do not find the cause of the problem locally, 
work with the remote administrators to determine the cause of the problem.

For quick results
When you test your implementation of Enterprise Networking, there are two 
ways to ensure quick results:

■ Change the batch threshold to 1.

■ Tag a test message as an urgent priority message.

An urgent tag ensures quick results. You do not need to change the scheduling 
parameters to perform the tests and return them to their original settings after 
you complete the tests.

Note: Messages tagged as urgent are handled according to the scheduling 
parameters. For example, if the urgent message hold time is five minutes, it may 
take five minutes before the test message is sent.

This coordinated site test determines if

end-to-end test ■ a remote system can receive messages 
from the local system.

loopback test ■ the local system can receive messages 
from the remote system.
Enterprise Networking Implementation and Administration Guide 205



Testing and backing up Enterprise Networking  Standard 1.0
Call routing test

Introduction
The call routing test determines if the local system

■ can make outbound calls to other sites using Enterprise Networking

■ cannot make outbound calls to numbers that are configured as restricted on 
the system

Before you begin
Ask the switch technician for the ACD/UCD agent and trunk printouts for the 
switch.

To perform the call routing test

1 Use the ACD/UCD agent and trunk printouts to select an ACD/UCD agent.

2 Program a telephone to use the same NCOS and TGAR as the agent.

Note: For instructions, consult your switch documentation.

3 Dial a network address.

4 Repeat steps 1–3 for a number that you know should be restricted.

Example: Attempt to access a trunk directly.

Evaluating test results
The call routing test is successful if an outbound call goes through to the allowed 
system but is blocked to a restricted system.

If the test is not successful
If the call routing test fails or produces unexpected results, a switch technician 
must check the switch settings that control routing and restrictions on calls.

What’s next?
After you successfully complete the call routing test, perform the local SDN test.
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Local SDN test

Introduction
The local SDN test verifies that the local system can receive messages from a 
remote system. This test confirms that the SDN for Enterprise Networking in the 
SDN Table is correct.

The quick SDN test can be substituted for the local SDN test. See “Quick SDN 
test” on page 209.

Note: The SDN for Enterprise Networking is, by default, the same default used 
by AMIS Networking.

If Enterprise Networking and AMIS Networking share an SDN with another 
service, send the message to that SDN when you enter the system access 
number.

The SDN test consists of sending a message to a mailbox at your local site. You 
address the message as if it is being sent to an Open AMIS site. You enter the 
system access number in dialable format. For this test, the system access number 
consists of the following:

■ the access code required to dial out of the system

■ your local site’s number, including the exchange code and SDN

To perform the SDN test

1 Log in to CallPilot.

2 Press 75 to compose a message.

3 Enter the following:

■ the AMIS compose prefix

■ the system access number

■ # to indicate the end of the system access number
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4 Enter the local mailbox number on which you are currently logged, followed 
by #.

Result: The system responds with the following message: Open network 
user <mailbox number> at <system access number>.

5 Press # again to indicate the end of the list of recipients.

6 Press 5 to record a message.

7 Record the message.

8 Press # to stop the recording.

9 Tag the message as urgent.

10 Press 79 to send the message.

Result: The system responds with the following message: Message 
sent.

11 Log off.

Evaluating test results
The message is sent according to the scheduling parameters for urgent messages.

The test is successful if you receive the message you recorded.

The test is not successful if you receive a non-delivery notification message.

If the test is not successful
If the SDN test is not successful, check the Enterprise Networking SDN in the 
SDN Table. Review the SDN setup requirements and make any necessary 
adjustments.

See also
For an overview of setting up SDNs, consult the Advanced Administration 
Guide.

For a detailed discussion of setting up SDNs for Enterprise Networking, consult 
“Adding and configuring SDNs” on page 112.

What’s next?
After you successfully complete the SDN test, perform the loopback test.
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Quick SDN test

Introduction
The quick SDN test verifies that the local system can receive messages. This test 
confirms that Enterprise Networking is correctly configured in the SDN Table.

The quick SDN test does not require the participation of a remote network 
administrator.

The local SDN test can be substituted for the quick SDN test. See “Local SDN 
test” on page 207.

To perform the quick SDN test

1 Log in to CallPilot.

2 From your local telephone, enter the local SDN for Enterprise Networking.

3 Listen for the system to answer the call.

4 Repeat these steps for every SDN used by Enterprise Networking.

Evaluating test results
The quick SDN test is successful if the system answers and waits for a C-tone. 
The system times out after approximately 20 seconds.

The test is not successful if any prompts are heard.

If the test is not successful
If the quick SDN test is not successful, check the Enterprise Networking SDNs 
in the SDN Table. Review the SDN setup requirements and make any necessary 
adjustments.

For detailed information on setting up SDNs, consult the relevant section in the 
Advanced Administration Guide.

What’s next?
After you successfully complete the SDN test, perform the loopback test.
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Loopback test

Introduction
A loopback test confirms that a message can be sent from a local site to a remote 
site, and returned to the local site.

You should perform this test after you add each remote site to the local database.

To perform the loopback test, compose and send a message to a loopback 
mailbox at a remote site. A loopback mailbox automatically returns a message to 
the originator.

Before you begin
Before you perform the loopback test, ensure that a loopback mailbox exists on 
each remote site tested.

Loopback mailbox
A loopback mailbox is a mailbox that is set up on every site in the messaging 
network. The only purpose of a loopback mailbox is to return a confirmation of 
receipt.

Get the loopback mailbox number from the network administrator of each 
remote site with which you are performing the loopback test.

To perform the loopback test

1 Log in to CallPilot.

2 Press 75 to compose a message.

3 Enter the network address of the remote site.

4 Enter the loopback mailbox number of the remote site.

5 Press 5 to record a message.

6 Record the message, and press # to stop recording.

7 Tag the message as urgent.

8 Press 79 to send the message.
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9 Wait for your Message Waiting Indicator light to activate. This light indicates 
that the message was successfully returned to you.

Note: Activation may take several minutes.

10 Log in and listen to the message.

11 Log out of the system.

Evaluating test results
The test is successful if you hear the message that you recorded.

The message is not successful if you receive a non-delivery notification 
message.

If the test is not successful
If the test is not successful, do the following:

■ Check with the remote network administrator and confirm the loopback 
mailbox number.

■ Perform the test again to ensure that the message was addressed correctly.

■ Consult the operational measurement reports to determine the following:

● Are the connection DNs correct?

● Is the remote site operational?

● Do the message transfer protocols match?

What’s next?
After you successfully complete the AMIS loopback test, perform the end-to-
end test.
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End-to-end test

Introduction
An end-to-end test verifies that users at a remote site can receive messages from 
users at the local site.

To perform the end-to-end test, send a message to a mailbox at a remote site. 
Send the test message to the mailbox of the remote network administrator and 
request a confirmation.

Before you begin
You must coordinate with the remote network administrator of each site with 
which you wish to perform a loopback test. Each remote administrator must 
listen to the message you have sent before returning an acknowledgment to you.

To perform the end-to-end test

1 Log in to a mailbox.

2 Press 75 to compose a message.

3 Enter the mailbox address for a mailbox at a remote site.

4 Press #.

5 Press # again.

6 Press 5 to record a message.

7 Record the message, and then press # to stop the recording.

8 Tag the message as urgent.

9 Press 79 to send the message.

10 Log out of the system and hang up.

11 Ask the remote administrator to log in to the mailbox and listen to the 
message.

12 Wait for an acknowledgment to be returned to you.

13 Log in to the mailbox and listen to the acknowledgment.
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Evaluating test results
The test is successful if the message is successfully delivered to the remote 
system.

The test is not successful if a non-delivery notification (NDN) is received, which 
indicates that the message was not delivered.

Confirming successful delivery
Even if you do not receive an NDN, you may want to confirm that the message 
was successfully delivered.

To confirm the delivery, either

■ log on to the remote site and read the message, or

■ ask the administrator at the remote site to log on and read the message

If the test is not successful
If the end-to-end test fails or produces unexpected results, check the following:

■ Was the message correctly addressed?

■ Does the mailbox on the remote system exist?

■ Does the NDN provide any indication of the problem?

If you receive an NDN, listen to the message to determine why the test 
message was not delivered.

IF the NDN states THEN

it took too many attempts to send 
the message

the cause may be

■ incorrect message transfer protocol.

■ incorrect site ID.

■ incorrect connection DN.

■ incorrect passwords.

■ the remote site is disabled.
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■ Do the alarms and events reports provide details of the possible causes?

Since all previous tests have been successfully completed, the remote site 
probably caused the test to fail.

Examples of remote site causes include the following:

● Incorrect password pairs were assigned between sites.

● Channels were not available.

● Addresses were incorrect.

● Connection DNs do not terminate on the networking DN.

● A remote site that is not yet operational was specified.

What’s next?
The end-to-end test is the final test in the Enterprise Networking test suite. When 
you successfully complete the loopback test, perform a backup of your 
configuration.

the address was incorrect the message was delivered to the remote site 
but could not be delivered. The cause may 
be

■ the mailbox does not exist.

■ the wrong mailbox number was used.

■ the Receive Composed Messages box on 
the Class of Services screen is set to No.

■ the disk at the remote site is full.

IF the NDN states THEN
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Backing up Enterprise Networking

Introduction
When all tests of the system are successfully completed and Enterprise 
Networking is working properly, perform a backup.

The backup ensures that the configuration is not lost due to system failure.

Backup schedule
Perform a manual backup as the final step in the AMIS Networking installation. 

Note: You must perform a manual backup even if the system is configured to 
perform an automatic backup. 

In the unlikely event that the system experiences a disk failure before the 
automatic backup takes place, the networking configuration could be lost.

Whenever you modify Enterprise Networking information during regular 
maintenance, perform a backup.

System backup components
A system backup consists of two parts:

■ switch backup

■ CallPilot backup

Switch backup
For detailed instructions on how to perform a switch backup, consult your 
switch documentation.

CallPilot backup
You can perform a full or partial backup of your CallPilot system. For detailed 
instructions on how to perform a CallPilot backup, consult the Advanced 
Administration Guide.
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c h a p t e r  8

Maintaining Enterprise Networking

After you complete the Enterprise Networking implementation, you only need to 
perform regular maintenance.

This chapter describes maintenance procedures that must be performed 
regularly. The chapter also describes maintenance procedures that you perform 
only when required.

In this chapter
About maintaining Enterprise Networking 219

Regularly scheduled maintenance tasks 225

As-required maintenance tasks 227

Maintaining remote users 249
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About maintaining Enterprise Networking

In this section
Overview 220

Maintain a network history 222

Printing configuration information 223
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Overview

Introduction
After you successfully install and test Enterprise Networking, you need to 
perform two types of maintenance tasks:

■ regularly scheduled

■ as-required

Regularly scheduled tasks
Regularly scheduled tasks include

■ checking the network status

■ reviewing Operational Measurement (OM) reports

Although you can perform regularly scheduled tasks at any time, perform these 
tasks at least once a week. Since these tasks do not interfere with the operation 
of the Enterprise network, you can schedule them at a convenient time during a 
regular workday.

If you monitor the performance of your messaging network, you avoid future 
problems. Careful monitoring shows bottlenecks in the system and indicates 
how the system can be improved.

Monitoring can also help you to plan and forecast future messaging network 
requirements.

As-required tasks
Perform as-required tasks as needs arise. As-required tasks include

■ modifying networking parameters

■ disabling and enabling Enterprise Networking

■ modifications to the Enterprise Networking configuration
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When to perform as-required tasks
Since as-required tasks may affect the entire system, perform these tasks when 
the system is not in heavy use.

Modifications to the configuration may be necessary for the following reasons:

■ New legal delivery times are announced for computer-generated calls.

■ The system performance suggests that adjustments to the parameters are 
required.

■ The system access number is changed.

Perform a backup following maintenance
Perform a backup of the system whenever you modify the network parameters as 
part of your maintenance.

ATTENTION! Because as-required tasks may affect the performance of 
the entire system, schedule them for off-peak hours.
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Maintain a network history

Introduction
Keep detailed records of a network’s history. These records can

■ indicate significant performance or equipment issues that real-time 
monitoring may not detect

■ provide a background for comparing the current information

■ provide information needed during support calls

Information to record
A network history should contain the following types of information:

■ installation dates and descriptions

■ contact information for all key personnel involved in the system installation 
and configuration

■ details of software installed on the messaging server, including versions

■ installation process and results, including tests

■ diagrams of the initial and subsequent network configurations

■ any problems encountered and their solutions

■ hardware and software changes

■ changes to the messaging network layout

Where to keep the records
Make the records of your messaging network easy to access and easy to read. 
Graphics, including hand-drawn sketches, can be very useful.

Keep records in a log or online. Note, however, that online records online cannot 
be accessed if the system fails.

See also
For a detailed description of messaging network histories, consult the 
Networking Planning Guide.
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Printing configuration information

Introduction
Printouts of the system configuration are often included in a network history. 
You can print all configuration information contained in your local network 
database.

To print configuration information, you must open the relevant Properties dialog 
box. For example, to print an item in the Messaging Network Configuration tree 
view, you must open the Properties dialog box of the item.

If a Properties dialog box consists of more than one tab, the contents of all tabs 
are printed.

Note: You cannot print the tree view of the messaging network contained in the 
Messaging Network Configuration dialog box.

When to print configuration information
Although configuration information is always available in the most recent 
backup of your network database, you may find it convenient to make printouts 
as well.

Printouts of the configuration information are especially useful in the following 
situations:

■ You must fax information to a remote network administrator.

■ You are keeping a network history.

■ You are planning to change a configuration or delete an item from the 
Messaging Network Configuration tree view, and you want a hard copy of 
the original configuration.
Enterprise Networking Implementation and Administration Guide 223



Maintaining Enterprise Networking  Standard 1.0
Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Message Delivery Configuration or Messaging 
Network Configuration

To print the configuration information

1 Open the dialog box that you want to print.

2 With the dialog box open, click the Print button.

Result: The contents of the dialog box print. The printout includes the 
contents of all tabs.
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Regularly scheduled maintenance tasks

In this section
Reviewing OM reports and alerts 226
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Reviewing OM reports and alerts

Introduction
Operational Measurement (OM) reports show how much of the CallPilot system 
is being used by Enterprise Networking.

Three OM reports provide Enterprise Networking information:

Although you can review OM reports at any time, you should review them at 
least weekly.

Access to OM reports is restricted
The generation of OM reports is a restricted activity that is determined by access 
level. If you do not have the necessary access, you must ask your system 
administrator to generate the reports.

The OM report request screens let you choose the reports that you want to view 
and print. For many reports, you can also customize the displayed results so that 
you receive the information in a format that best suits your needs.

See also
For additional information on OM reports, including how to interpret them, 
consult the Reporter Guide.

This OM report provides

Open Networking Activity information about open networking activity 
over a specified time interval.

Network Usage Bill-back information to bill back the cost of users’ 
networking activities.

Failed Networking Sessions 
alert

notification that the number of networking 
failures equals or exceeds the total number of 
networking attempts.
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As-required maintenance tasks

In this section
Overview 228

Modifying the Enterprise Networking configuration 230

Disabling and enabling Enterprise Networking 232

Modifying message delivery parameters 235

Modifying the channel resource allocation 237

Add, modify, or delete remote sites 239

Locating an item in the tree view 241

Modify a remote site configuration 242

Deleting items in the tree view 245

Modifying dialing plan information 248
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Overview

Introduction
You may need to modify the Enterprise Networking configuration, including

■ whether the system can send or receive Enterprise messages

■ the time periods when outgoing messages are allowed to be sent during 
business and nonbusiness days

■ the minimum and maximum port allocation for Enterprise Networking

■ how many messages to transmit in each Enterprise Networking session

■ the scheduling parameters

Scheduling parameters
The scheduling parameters that may be modified are

■ economy message send time

■ stale times for economy, standard, and urgent messages

■ batch threshold

■ delivery days and times

Identifying required modifications
Changes to the Enterprise Networking configuration may be required if

■ message delivery scheduling is not performing as anticipated

■ there are changes to the long-distance charge period or to delivery days and 
times
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Example 1
When you originally configured the system, you set the economy delivery start 
time to 8:00 p.m. and the stale time to 4 hours. Users find that many of their 
messages are going stale and are being returned with non-delivery notifications.

A coordination problem exists between the two scheduling parameters. If you 
compose an economy message in the morning, it may go stale before the 
delivery time begins. Therefore, you must reconfigure the stale time to 20 hours, 
for example. This reconfiguration ensures that messages can be composed 
throughout the business day and will not go stale before the delivery begins.

Example 2
When you originally configured Enterprise Networking, the lower rates for long 
distance came into effect at 11:00 p.m. Therefore, you set the economy delivery 
start time to 11:00 p.m.

However, the telephone company has announced new periods for lower long-
distance toll rates. Lower rates now begin at 8:00 p.m. Therefore, you change the 
economy delivery start time to 8:00 p.m.
Enterprise Networking Implementation and Administration Guide 229



Maintaining Enterprise Networking  Standard 1.0
Modifying the Enterprise Networking 
configuration

Introduction
If you need to modify the Enterprise Networking configuration, follow these 
general guidelines.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Message Delivery Configuration > Enterprise tab

To modify the Enterprise Networking configuration

1 Review Chapter 5, “Configuring CallPilot for Enterprise Networking”, to 
ensure that you understand the impact of the changes.

2 Enter all required modifications on the Enterprise tab.

3 Click Save.

Result: The system validates the modifications and, if they are valid, puts 
the modifications into operation immediately.

CAUTION!
. 

Risk of loss of functionality
Changes to the networking configuration should be done 
during hours when users are not logged on. Making changes 
to the configuration while users are logged on may result in 
loss of messaging functionality.
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Announce some modifications
Most of the modifications that you make to the Enterprise Networking 
configurations are transparent to your users. Although modifications may affect 
the performance of the system, they do not require any new input from users.

However, if you modify the Enterprise site ID, you must announce this change to 
all local users.

If you modify the SAN, you must notify remote callers about this change. Also 
remind your local users to tell users at the open sites about the changes.

Perform a backup
After you modify the configuration of Enterprise Networking, perform a backup 
to ensure that these changes are not lost.

Also record the changes in your network history.
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Disabling and enabling Enterprise Networking

Introduction
You may need to disable Enterprise Networking occasionally. When you disable 
Enterprise Networking, users cannot compose, send, or receive Enterprise 
messages.

You might disable Enterprise Networking to

■ prevent system abuse

■ temporarily suspend outgoing or incoming messages, or both

Messages sent while system is disabled
When you disable outbound Enterprise Networking, your local users can 
continue to compose and send messages. The messages composed by your local 
users are held in queue until the option is enabled or the message becomes stale.

When you disable inbound Enterprise Networking, messages from remote 
systems are rejected. The remote system that sends the message is informed of 
the status, and messages are not accepted.
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Message Delivery Configuration > Enterprise tab

To disable and enable Enterprise Networking

1 Do the following:

2 To save your settings, click Save.

Other ways to disable and enable Enterprise Networking
There are several ways to disable and enable Enterprise Networking. Use the 
most appropriate method, depending on the circumstances.

In addition to the Message Delivery Configuration method described above, the 
following methods are available:

IF you want to THEN

disable your system from receiving 
Enterprise messages

clear the Incoming Enterprise 
Networking check box.

disable your system from sending 
Enterprise messages

clear the Outgoing Enterprise 
Networking check box.

enable your system to receive Enterprise 
messages

select the Incoming Enterprise 
Networking check box.

enable your system to send Enterprise 
messages

select the Outgoing Enterprise 
Networking check box.

IF you want to THEN

disable or restrict the sending of 
Enterprise Networking messages 
to specific or all SANs by a user

change the Enterprise Restriction/
Permission List for the user.
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disable the sending of messages 
to any remote site, using any 
protocol, by the local server

clear the Send Messages to all other Servers 
option in the Messaging Network 
Configuration dialog box for the local 
server.

Note: This option is available only if 
additional networking solutions are 
installed on your local system.

disable the sending of messages, 
using the defined protocol, to a 
specific remote site

clear the Send Messages to all other Servers 
option in the Messaging Network 
Configuration dialog box for the remote 
server.

Note: This option is available only if 
additional networking solutions are 
installed on your local system.

IF you want to THEN
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Modifying message delivery parameters

Introduction
Message delivery parameters control when and how Enterprise Networking 
sends messages. You can modify the following message delivery parameters as 
required:

■ batch threshold

■ stale times

■ economy delivery start and stop times

Impact of modifications
The message delivery parameters are closely interrelated. Modifications to one 
parameter may necessitate changes to others. Therefore, carefully plan 
modifications in advance.

You must test and monitor the performance of the system after you make any 
modifications to ensure that the modifications have the desired effect and no 
unplanned side effects.

Note: Before you modify the message delivery parameters, review the previous 
discussion of how these parameters are set in Chapter 5, “Configuring CallPilot 
for Enterprise Networking”.
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Message Delivery Configuration > Enterprise tab

To modify message delivery parameters

1 Modify the delivery parameters on the tab as required.

2 Review the changes to ensure that there are no conflicts among the 
parameters.

3 Click Save.

Perform a backup
After any modification to the configuration, perform a backup to ensure that the 
modification is not lost.
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Modifying the channel resource allocation

Introduction
When you implemented Enterprise Networking, you set the minimum and 
maximum channel resource allocation for both the inbound and the outbound 
Enterprise Networking SDNs. The channel resources determine how efficiently 
services are accessed.

Balance channel resources
You must carefully balance channels for each service when you allocate channel 
resources. You must allocate enough channels to ensure that users can access the 
service. However, you must not overallocate channels so that users are unable to 
access other services.

Determine if modifications are necessary
To determine if modifications to the channel resource allocation are necessary, 
monitor service usage. After Enterprise Networking is in service for a period of 
time, use the Reporter feature to determine how services are being used.

Reporter provides the following statistics:

■ the number of calls queued for a service

■ the average wait time for queued calls

■ the maximum wait time for queued calls

■ the number of callers who abandoned the queue

If you are dissatisfied with the performance of AMIS Networking after 
analyzing these statistics, modify the resource allocation. However, remember 
that modifications to the resource allocation for one service may affect the 
performance of other services.
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Getting there  Nortel SMI > Meridian Application Server > System Configuration 
> Service Administration > Service Directory Number > Service 
Directory Number Table

To modify an SDN

1 In the SDN Table, select the SDN you want to modify.

2 On the File menu, select Properties.

Result: The Edit Service Directory Number properties dialog box appears.

3 Make the necessary modifications.

4 Click Save.
238 CallPilot



October 2003 Maintaining Enterprise Networking 
Add, modify, or delete remote sites

Introduction
As your messaging network grows and changes, you may need to add or delete a 
remote site, or to modify the configuration of an existing remote site.

It is very important that all network administrators keep the information in their 
network database up-to-date.

Before you begin
Before you add, modify, or delete a remote site, create a printout of all 
configuration information that will be affected.

Add a remote site
When you add a site to the messaging network, all sites add the new site to their 
Messaging Network Configuration tree view. The remote administrator must 
provide the information necessary to add and configure a remote site.

Modify a remote site
You can modify the configurations of both the messaging server and the switch 
locations as needs change. For example, if a remote site upgrades its system, you 
must modify its configuration information in your network database.

It is important that the information in your network database reflect the actual 
configuration of the remote site. The remote network administrator must inform 
you of all necessary changes.
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Delete a remote site
When you remove a site from the messaging network, the site must be deleted 
from the Messaging Network Configuration tree view.

Impact on network database
Your network database reflects any additions, modifications, or deletions to 
remote sites. For this reason, you should perform the Enterprise Networking test 
suite again, as well as a backup.
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Locating an item in the tree view

Introduction
It can be difficult to locate a particular remote site, messaging server, or switch 
location in the Messaging Network Configuration tree view in a very large 
messaging network.

There are two ways to locate an item in a large messaging network:

■ Scroll through the alphabetized list.

■ Use the Find feature.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration

To locate an item using Find

1 On the File menu, select Find.

Result: The Find dialog box appears.

2 Enter the name of the item to be located, and press the Find button.

Result: The located item is highlighted in the Messaging Network 
Configuration tree view.
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Modify a remote site configuration

Introduction
Modify the configuration of a remote site as required.

To modify a remote site, you must open the Messaging Network Configuration 
tree view and select the remote messaging server or switch location that you 
wish to modify.

Further information
Make modifications to the configuration on the Properties dialog box where the 
initial configuration was made. To review the settings, consult the instructions 
for the initial configuration.

Impact of modifications
When you modify the configuration of a remote system,  networking service 
between the remote site and your local site may be affected. Modifications to the 
following settings are especially important:

■ site IDs

■ connection DN

■ dialing plans

■ message transfer protocol

To review the settings on this 
Properties dialog box consult

Remote Messaging Server “Configuring a remote messaging server” 
on page 166.

Remote Prime Switch Location “Configuring a remote prime switch 
location” on page 175.

Remote Satellite Switch Location “Configuring a remote satellite switch 
location” on page 187.
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Enterprise Site IDs
Do not change the remote site ID unless the administrator at the remote site 
notifies you of a change in that ID, or if the ID is incorrect.

If you change the site ID to an invalid number by mistake, the system is unable 
to send or receive messages from the site.

Connection DN
Do not change the connection DN to a remote site unless

■ the administrator at the remote site notifies you that the DN in the SDN 
Table is changed, or

■ you are changing the message transfer protocol

Dialing plans
Do not change the dialing plan unless the dialing plan on the switch is changed.

Message transfer protocol
Do not change the message transfer protocol unless all network administrators 
who use the protocol to exchange messages with your site agree to the change.
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration 

To modify the configuration of a remote site

1 In the Messaging Network Configuration tree view, select the remote 
messaging server or server that you want to modify. 

2 On the File Menu, select Open.

Result: The Properties dialog box for the selected item opens.

3 Make all required modifications.

4 Click Save.

Result: The modifications are validated and saved to the network 
database.

5 Repeat steps 1–4 for all items in the tree view that must be modified.

After modifications are complete
You must test modifications to the configuration of a remote site. Complete the 
test suite to ensure that the modifications work properly.

When you are satisfied that your system is working properly, perform a backup.
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Deleting items in the tree view

Introduction
The Messaging Network Configuration tree view contains all sites in your 
messaging network with which the local site exchanges messages.

A site always consists of a messaging server and a prime switch location. A site 
may also include satellite switch locations.

Sites and satellite switch locations are deleted from the Messaging Network 
Configuration tree view.

Note: You cannot delete the local site. You can delete local satellite switch 
locations.

Multi-administrator environments
If several administrators maintain your local network database, ensure that your 
view of the Messaging Network Configuration tree view is up-to-date. The 
Messaging Network Configuration tree view is updated when it is initially 
opened. An open tree view is not updated when another administrator makes 
changes.

To check the status of the view
To see if another administrator has made changes to the Messaging Network 
Configuration tree view, on the View menu, click Refresh.

ATTENTION! When an item is deleted from the Messaging 
Network Configuration tree view, it is permanently 
removed from the local network database. The 
information cannot be recovered.For this reason, it 
is strongly recommended that you print out the 
complete configuration of all items to be deleted. If 
an item is accidentally deleted, you can use the 
printed information to add the item again.
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration

To delete a remote site

1 Print the configuration details of the site that you want to delete.

2 Open the folder of the remote site to see the messaging server, prime 
switch location, and any satellite switch locations.

3 In a multi-administrator environment, on the View menu, click Refresh.

4 Highlight the messaging server of the site that you want to delete.

5 Select File > Delete.

Result: A confirmation box appears asking if you really want to delete the 
site from your local network database.

6 To delete the site, click Yes.

Tip: You can also delete a highlighted remote site by clicking the Delete 
button.

Deleting several remote sites at once
If you must delete several remote sites from the local network database, you may 
find it more efficient to delete all the sites at once.

To delete several remote sites at once

1 Print the configuration details of all the sites that you want to delete.

2 In the tree view, highlight all the remote sites that you want to delete.

Tip: To select more than one item in the tree view, press Ctrl and right-click 
the mouse.

3 Select File > Delete.

Result: A confirmation message appears. To delete the sites, click Yes. To 
keep the sites, click No.
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Deleting a satellite switch location
If there are changes to an NMS site, you can delete one or more satellite switch 
locations from the local site or from any remote sites.

If you remove a satellite switch location from an NMS site, you must also 
remove it from the local network database.

To delete a satellite switch location 

1 Print the configuration details of the satellite switch location.

2 In a multi-administrator environment, on the View menu, click Refresh.

3 Highlight the satellite switch location that you want to delete.

4 On the File menu, click Delete.

Result: A confirmation message appears. To delete the sites, click Yes. To 
keep the sites, click No.
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Modifying dialing plan information

Introduction
After you establish a dialing plan, you rarely modify it. Modifications to a 
dialing plan affect users and may require considerable relearning of the system.

However, if modifications are necessary, they are usually guided by changes 
made by the switch technician. These changes can be local or remote.

Switch changes
If any changes to the dialing plan are made on a switch,  the network databases 
of the sites in the messaging network must reflect these changes. If changes are 
made locally, ensure that all remote sites are notified.

To modify the dialing plan information
If you need to modify the dialing plan, follow the general instructions to modify 
the local and remote sites.

Modifying CDP steering codes
Modifications to the CDP steering codes are more complicated. For a detailed 
review of how to plan for and implement changes, consult Chapter 4, “Dialing 
plans and networking,” in the Networking Planning Guide.

Initiating and responding passwords
If you modify the initiating or responding password for a remote site in your 
network database, you must ensure that the same change is made in the network 
database of the remote site.

The initiating and responding passwords in both databases must match to ensure 
proper communication between sites.

See also
For a review of how initiating and responding passwords must be set up, consult 
“Initiating and responding passwords” on page 72.
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Maintaining remote users

In this section
Overview 250

Adding remote users with User Administration 251

Finding remote users 254

Printing a list of remote users 258

Modifying records of remote users 259

Manually deleting remote voice users 260
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Overview

Introduction
After you have added remote users, you will have to perform regular 
maintenance activities to keep your system working optimally.

Maintenance activities
Common maintenance activities include the following:

■ Add remote users.

■ Find remote users.

■ List remote users.

■ Print remote users.

■ Modify remote users.

■ Delete remote users.
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Adding remote users with User Administration

User Administration
With User Administration, you can manually add temporary and permanent 
remote users. Remote users are added one at a time.

User Administration requires you to enter detailed information for each remote 
user, including

■ general information

■ settings information

General information
Personal identification information is required for every remote user. This 
information includes

■ last name, first name, and initial

■ comments

■ title and department

The personal identification information should be as complete as possible.

Check the spelling of the remote user’s name. The name that you enter is used by 
Name Dialing and Name Addressing.

Setting information
Setting information includes the following:

■ mailbox number

■ primary, secondary, and tertiary DNs

■ whether a personal verification is recorded

■ whether the remote user can be name-dialed by external callers

■ whether the remote user has temporary status
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Mailbox number
The remote user’s mailbox number must be in network format and must include 
the network prefix or steering code required to address to the mailbox. For 
example, if the remote user’s mailbox number is 4433 and the ESN prefix is 
6233, enter 62334433.

DNs
A remote user can have up to three extension DNs. This means that a caller can 
dial any one of these numbers and reach the remote user.

The DNs must be in network format and must include the network prefix or 
steering code required to call the remote user.

Personal verification recorded
When a remote user is added with User Administration, the remote user’s own 
voice cannot be used for the personal verification. The system administrator 
must record a personal verification on behalf of the remote user.

When a personal verification has been recorded for the remote user, the Personal 
verification recorded box says Yes.

When a personal verification has not been recorded for the remote user, the 
Personal verification recorded box says No. Instead of a personal verification, 
callers hear the mailbox number and the site spoken name, if one exists.

Name-dialable by external callers
The remote user can be name-dialed by external callers who are not part of your 
network.

Temporary user
The remote user can either be a temporary user or a remote user. This status can 
be changed as required.
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Last access time
Monitor the activity of remote users to ensure that the system is used optimally. 
For example, if a permanent remote user has not used the system for a year, it 
may be best to change the user’s status from permanent to temporary.

When you add a remote user to your database, the last access time is 
automatically filled in. The last access time is automatically updated whenever 
the remote user uses the system.

Adding a remote user manually
You can add a remote system to your network database manually.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > User 
Administration > User Creation Template

To add a remote user with User Administration

1 In the User Creation Template list, select Remote User Template.

Result: The New User Template appears.

2 Ensure the User Properties and Mailbox Capabilities check boxes are 
selected.

3 On the General tab, complete all required information.

4 On the Settings tab, complete all required information.

5 Click Save.
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Finding remote users

Introduction
CallPilot enables you to find all users on your local system, including remote 
users.

Finding a remote user is often your first step in a maintenance activity.

Methods available
There are two ways to find a remote user or a group of remote users.

To find a remote user whose mailbox number is known

1 From User Administration, select Remote User.

2 Select the Remote User item and press Enter. 

Result: You are prompted to enter a mailbox number.

3 Enter the remote user’s mailbox number, including the access code and 
network prefix, and press Return.

Result: The information for the remote user appears.

Finding a remote user whose mailbox number is not known
If you do not know a remote user’s mailbox number, you can find the user by 
performing a search of the remote user database. You can use this method to find 
a single remote user or a group of remote users who share some characteristics.

IF THEN

you know the remote user’s mailbox 
number

use the Remote User dialog box.

you do not know the remote user’s 
mailbox number

use the Find Remote User dialog box.
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You can use various search criteria to help narrow your search. The search 
criteria are what you know about the remote user, or group of remote users. 
CallPilot searches your database and returns a list of all users who meet the 
specified criteria.

Search criteria
You can perform a search based on the following fields:

■ Mailbox number

■ Last name

■ First name

■ Department

■ Title

Wildcards in search criteria
When you are unsure of a character or string of characters in your search criteria, 
you can use wildcards. Wildcards represent the unknown characters.

For example, if you do not know if a remote user’s last name is spelled Johnski 
or Jonski, you can enter Jo+nski. Your search will locate all remote users whose 
last name begins with Jo and ends with nski.

There are two valid wildcards:

■ The underscore (_) replaces a single character.

■ The plus sign (+) replaces a string of characters.

Wildcards can be used in the following fields:

■ Mailbox number

■ Last name

■ First name

■ Department

■ Title
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Examples
The following examples illustrate how the Find function can be used:

■ You need to find Robert Jones in the Technology Department.

■ You need to find an employee whose last name is Mordavia, but you do not 
know if she uses the first name Elizabeth, Beth, or Liz.

■ You must locate all users who have not yet recorded a personal verification.

■ You must find all users in the New Productions department so that they can 
be reassigned to the new Research and Development department.

Results: When the remote users are found, they are presented in a list. The 
following information is provided for each found remote user, if available:

■ last name

■ first name

■ title

■ department

■ comments

Uses of the results list
The list of remote users that is displayed as a result of a search has various uses.

View or modify a found remote user
You can view the information contained in the database for any remote user in 
the list.

To view the information, select the remote user whose information you want to 
view, and press Enter. The remote user’s User Administration screen appears.

You can modify the information about the remote user, including recording a 
personal verification for a remote user or changing the status of a remote user 
between temporary and permanent.

To modify the information, make all required changes to the information and 
press Enter. The database is updated.
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Delete a remote user
Delete all remote users who are not required.

See also
For more information about working with users, consult the Basic 
Administration Guide.
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Printing a list of remote users

Introduction
You can print a list of all the remote users in your network database. This list 
provides detailed information about the remote users and their activities. Review 
this list as part of the regular maintenance of remote users in your network 
database.

Getting there  Nortel SMI > Meridian Application Server > User Administration > 
Users

To print the list of remote users

1 In the Users dialog box, on the File menu, click Open Search.

Result: The Search Users dialog box opens.

2 In the Condition box, select User Type.

3 In the Operator box, select “Is.”

4 In the Value box, select Temporary or Permanent Remote Users.

5 Click Search.

Result: A list of all remote user appears.

6 On the File menu, select Print.
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Modifying records of remote users

Introduction
You can modify the information about remote users when required. Modification 
of remote user records is important for keeping records up-to-date.

Example
Hanna Moos is a permanent remote user at your site. Recently she was promoted 
and moved from the sales department to a senior management position in 
marketing. She received a new mailbox number as well.

You modify the information contained in your database to reflect these changes. 
In addition to changing the department and mailbox number fields, you change 
Hanna’s status from temporary to permanent.

Before you begin
To modify any information about a remote user, first find the remote user’s 
records.

Getting there  Nortel SMI > Meridian Application Server > User Administration > 
Users

To modify a remote user

1 Find the record of the remote user that you want to modify.

Note: For procedures on finding a remote user, consult “Finding remote 
users” on page 254.

2 Open the record of the remote user.

3 Make any necessary changes.

4 Click Save.
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Manually deleting remote voice users

Introduction
You can manually delete any remote user, both temporary and permanent.

Example
Two remote users, Pedro Afonso and Yang Wang, recently left your company. 
You would like to remove them from your database. Pedro is a permanent 
remote user. If you do not manually remove his record, it will remain in your 
database indefinitely. Yang is a temporary remote user. If you do not manually 
remove his record, it will remain in the system until a nightly audit eventually 
removes it.

Before you begin
To manually delete a remote user, first find the remote user’s records.

To manually delete a remote user

1 Find the record of the remote user that you want to delete.

Note: For procedures on finding a remote user, consult “Finding remote 
users” on page 254.

2 Open the record of the remote user and make sure that it is the correct 
remote user.

3 To delete the record, click Remove.

4 Click Save.
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c h a p t e r  9

Troubleshooting Enterprise 
Networking

Although testing and regular maintenance procedures ensure that Enterprise 
Networking is operating properly, the system may experience occasional 
problems. This chapter describes how to diagnose and correct these problems.

In this chapter
About troubleshooting Enterprise Networking 263

Determining if problems are switch-related 269
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About troubleshooting Enterprise 
Networking

In this section
Overview 264

Determining if Enterprise Networking is disabled 266

Reviewing Alarm and Event reports 267

Reviewing Operational Measurement reports 268
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Overview

Introduction
If you are experiencing problems with Enterprise Networking, this chapter will 
help you to identify and solve these problems.

Common causes of Enterprise Networking problems include the following:

■ Enterprise Networking is disabled.

■ The status of a remote site prevents it from receiving messages from the 
local site.

■ Networking configuration is incorrect or incomplete.

■ The switch is configured incorrectly.

■ There are hardware problems.

Identifying the source of the problem
To identify the source of the problem, first determine if Enterprise Networking is 
disabled.

If Enterprise Networking is properly enabled, then review the following:

■ appropriate Alarm and Event reports

■ network status

■ Operational Measurement (OM) reports

Configuration errors
Configuration errors may include the following:

■ incorrect connection DNs

■ message transfer protocols that do not match between the remote and local 
sites

■ incorrect dialing plan information, including ESN prefixes and CDP 
steering codes

■ scheduling parameters that need to be modified
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Site status errors
A site can be either intentionally disabled or put into error status.

A remote site may be put into error status because of unsuccessful attempts by 
the local site to deliver messages to the remote site. Failed message delivery can 
happen for the following reasons:

■ The remote site is experiencing hardware or software problems.

■ There are site configuration errors.

Switch-related problems
If you are unable to identify the problem using CallPilot, the error may be 
switch-related. Perform the call trace test.

Call trace
Call trace helps you to determine if network calls are being blocked for one or 
more of the following reasons:

■ Digit manipulation is performed incorrectly. Either not enough or too many 
digits are inserted or deleted.

■ Class of service restrictions are either too stringent or too loose.

■ Dialing is incorrect. More digits are required by the trunks or trunk routes.

On the switch, you can perform a call trace on a telephone or on a trunk and a 
trunk route.

Hardware problems
If you are unable to locate the problem in the CallPilot networking configuration 
or in the switch, your system may be experiencing hardware problems that are 
not related to networking.

Solution
Perform a basic hardware check. Examine all connections.
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Determining if Enterprise Networking is 
disabled

Introduction
You must enable Enterprise Networking to receive incoming Enterprise 
messages and to deliver outgoing Enterprise messages.

Begin any troubleshooting session by determining if Enterprise Networking is 
properly enabled.

There are several methods of disabling and enabling the sending and receiving 
of Enterprise Networking messages. 

To determine if Enterprise Networking is disabled
To determine if Enterprise Networking has been disabled to receive incoming 
messages or to send outgoing messages, or both, check the settings on the 
Enterprise tab of the Message Delivery Configuration dialog box.

1 From the Message Delivery Configuration dialog box, select the Enterprise 
tab.

2 Check the settings of the Outgoing Enterprise networking and Incoming 
Enterprise networking check boxes. Ensure that these check boxes are 
selected as required for your system.

3 Click Save to exit and save any changes that you made.

IF THEN check this setting

the system does not receive 
incoming messages

Incoming Enterprise messages enabled.

the system does not deliver 
outgoing messages

Outgoing Enterprise messages enabled.
266 CallPilot



October 2003 Troubleshooting Enterprise Networking 
Reviewing Alarm and Event reports

Introduction
Alarm and Event reports track and report system errors and unusual events. 
These reports can be viewed on-screen or printed, or both.

Reports related to Enterprise Networking
The following reports are useful for monitoring Enterprise Networking:

■ Networking Activity report

■ Network Usage Bill-back report

■ Failed Networking Sessions alert

See also
For instructions on reviewing and interpreting Alarm and Event reports, consult 
the Reporter Guide.
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Reviewing Operational Measurement reports

OM reports
Operational Measurement (OM) reports contain detailed information on how the 
system is functioning. When you attempt to locate problems with Enterprise 
Networking, review these reports.

When you review the OM reports, consider the following:

See also
For detailed instructions on producing, reviewing, and interpreting Operational 
Measurement reports, consult the Reporter Guide.

This OM result suggests

large number of accesses the holding time may be too low, or the batch threshold is 
too small.

excessive “Failed to Send” 
messages

the remote system may be down, or the dialing 
translations are incorrectly configured, or the call 
maximum number is too small.

high number of NDNs users are entering incorrect addresses, or mailboxes do not 
exist on the remote system.

networking traffic is 
excessive

an unusual or cyclical event affected the system, or the 
number of channels used by Enterprise Networking is too 
small, or the number of channels available to Enterprise 
Networking is too small.

failures the remote system does not support the Enterprise 
Networking protocol, or the number of channels is too 
small.
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Determining if problems are switch-
related

In this section
Switch-related problems 270

Call trace test 271

Link diagnostic test 273
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Switch-related problems

Enterprise Networking problems and the switch
If you cannot identify the cause of the Enterprise Networking errors using 
CallPilot, the problem may be switch-related.

The following tests identify switch-related problems:

■ call trace

■ link diagnostic
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Call trace test

Purpose
If you cannot identify the Enterprise Networking problem using CallPilot, calls 
may be blocked by the switch. The call trace test determines

■ if calls are blocked

■ why calls are blocked

Why calls are blocked
A network call can be blocked for one or more of the following reasons:

■ Digit manipulation is performed incorrectly. Not enough or too many digits 
are inserted or deleted.

■ Class of service restrictions are too stringent or too loose.

■ Dialing is incorrect. More digits are required by the trunks or card trunk 
routes.

Where a call trace is performed
On the switch, you can perform a call trace on a telephone or on a trunk and 
trunk route.

Before you begin
To interpret the results of a call trace test, you need to understand

■ how the switch processes calls

■ how to interpret the results of a call trace session

A switch technician should perform the call trace test and interpret the results.
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The information that is required to perform the call trace test varies for each type 
of switch. However, the following information is usually required:

■ your customer number

■ the directory number that will be tested

■ the type of telephone and key number (for multiline telephones)

■ the terminal number (loop, shelf, card, unit) of the telephone or trunk that 
will be tested

■ the route type and trunk number of the trunk and trunk route that will be 
tested

To perform the call trace test
Follow the instructions in your switch documentation.

How to interpret the results
For guidelines on how to interpret the results of the call trace test, consult your 
switch documentation.
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Link diagnostic test

Purpose
If you cannot identify the cause of the networking problem on the CallPilot or by 
performing the call trace test, the problem may not be related to networking.

The link diagnostic test determines if the link between the switch and the name 
of server is working.

Before you begin
The link diagnostic must be performed by a switch technician.

To perform the link diagnostic test
Follow the instructions in your switch documentation.
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Description, 176
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and switch, 116
for Enterprise Networking, 116

disabling Enterprise Networking, 126, 232
other methods, 233

dual-tone multifrequency signaling, 47

E
economy message

delivery start and stop times, 71, 127
economy priority message, 67
Economy Tag, 52
enabling Enterprise Networking, 126, 145, 232

other methods, 233
end-to-end test

evaluating results, 213
procedure, 212
purpose, 205

Enterprise Location ID
local prime switch location, 153
remote prime switch location, 177

Enterprise Networking
and CallPilot, 46
and Names Across the Network, 54
backing up information, 63
configuring a remote messaging server, 173
configuring a remote satellite switch 

location, 189
configuring CDP information, 162
configuring CDP information for remote 

prime switch location, 185
configuring ESN information for a remote 

prime switch location, 182
configuring parameters, 129
configuring the local server, 148
definition, 46

determining if disabled, 266
directory number, 116
disabling, 126, 232
enabling, 126, 232
Enterprise Location ID, 177
Enterprise Site ID, 147
features, 50
gathering information, 90
implementation in a complex messaging 

network, 64
implementation overview, 60
in complex network, 48
information validation, 62
internal controls, 76
local site configuration, 142
maintaining, 220
message, 47
message contents, 66
message handling, 66
modifying an SDN, 238
modifying channel resource allocation, 237
modifying configuration, 228
modifying message delivery parameters, 

235, 236
Names Across the Network, 146
parameters, 68
performing backups, 215
phantom DN, 117
preliminary requirements for configuration, 

136
protocol used, 47
receiving message text information, 147
relevant OM reports, 226
sending message text information to a remote 

site, 170
site IDs, 48
switch configuration required, 104
switch requirements, 104
switch settings required, 96, 116
switch-related problems, 270
testing, 62
troubleshooting overview, 264

Enterprise Networking protocol, 47
Enterprise Networking test suite, 204

call routing test, 204
end-to-end test, 205
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local SDN test, 204
loopback test, 205

Enterprise Site ID, 48
description, 72, 147
modifying, 243
remote messaging server, 170

Enterprise tab, Message Delivery Configuration 
dialog box, 126

ESN
access code, 157
location code, 157
location code overlap, 157

ESN dialing plan, configuration overview, 156
ESN information

remote prime switch location, 181
ESN tab

Prime Switch Location Properties dialog box, 
151

Remote Prime Switch Location Properties 
dialog box, 175

Remote Satellite Switch Location Properties 
dialog box, 187

evaluating gathered information, 96

F
Failed Networking Sessions alert, 226
Fax Call Answering CDN queues, 116
fax channel type, 108
features of Enterprise Networking, 50
Find key, using to locate an item, 241
finding a remote site, 241
finding a remote user, 254
finding problem with Enterprise Networking, 

264
FQDN of local SMTP/VPIM server, 142, 147

G
gathering information

checklist, 94
evaluating, 96
for network, 61
from other sites, 97
from switch, 91

purpose, 90
remote switch location checklist, 95
required from switch, 93
switch information, 61
to implement Enterprise Networking, 90

General tab
Prime Switch Location Properties dialog box, 

151
Remote Messaging Server Properties dialog 

box, 167
Remote Prime Switch Location Properties 

dialog box, 176, 187
Remote Switch Location Properties dialog 

box, 175

H
hardware problems, 265
header contents, 66
holding time

description, 69
interaction with batch threshold, 128
relationship to stale time, 128
standard messages, 69
urgent messages, 69

holding time for standard messages
default value, 124

holding time for urgent messages
default value, 124

how a message is transferred, 82
how to

add a remote user with User Administration, 
253

add and configure a new inbound service 
directory number (SDN), 113

check Enterprise Location ID, 196
configure a remote messaging server, 173
configure a remote satellite switch location, 

189
configure CDP information, 162
configure CDP information for a remote 

prime switch location, 185
configure Enterprise Networking parameters, 

129
configure ESN information, 158
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configure ESN information for remote prime 
switch location, 182

configure local prime switch location, 155
configure the local messaging server, 148
create a loopback mailbox, 132
delete a remote site, 246
delete a satellite switch location, 247
delete several remote sites, 246
determine if Enterprise Networking is 

disabled, 266
disable Enterprise Networking, 233
enable Enterprise Networking, 233
find a remote user with a known mailbox 

number, 254
find a remote user with an unknown mailbox 

number, 254
import a spoken name, 194
locate an item using Find, 241
modify an SDN, 238
modify dialing plan information, 248
modify message delivery parameters, 236
modify remote site configuration, 244
modify the Enterprise Networking 

configuration, 230
open the Prime Switch Location Properties 

dialog box, 152
print configuration information, 224
print list of remote users, 258
record a spoken name, 192
share an existing inbound service directory 

number (SDN), 114

I
impact of modifications, 235
implementation

backup, 63
configuring CallPilot, 62
configuring the switch, 61
gather information for network, 61
main steps, 60
order in complex messaging network, 64
overview, 60
parameters set during, 68
preliminary requirements, 60

recommended order in complex messaging 
network, 64

testing, 62
validation, 62

implementing Enterprise Networking, NMS 
local site, 137

importing a spoken name, 193, 194
inbound service directory number (SDN)

how to add and configure new, 113
how to share existing, 114
services that can share, 112
ways to set up, 112

indicators in OM reports, 268
information, gathering to implement Enterprise 

Networking, 90
initiating password, 172

description, 72
modifying, 248

installation and configuration guides, 19
Integrated AMIS Networking

implementation, 64

L
last access time, 253
link diagnostic test, purpose, 273
local messaging server name, 142
local prime switch location

configuration if NMS local site, 150
configuration if other networking solution 

implemented, 150
configuration overview, 150
configuration procedure, 155
description, 153
Enterprise Location ID, 153
mailbox prefix, 154
name, 153
Prime Switch Location Properties dialog box, 

151
recording spoken name, 153

local SDN test
evaluating results, 208
procedure, 207
purpose, 204

local server
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configuration if another networking solution 
implemented, 143

configuration overview, 144
configuration process, 148
name, 145
server type, 145

local server FQDN, 147
local site configuration, 142
local site name, 142, 145
locating a remote user, 254
locating remote site, 241
location code

ESN, 157
overlap, 157

loopback mailbox
creating, 132
definition, 131
description, 131
requirements, 131
using, 132

loopback test
evaluating results, 211
procedure, 210

M
mailbox addressing follows dialing plan

local prime switch location, 154
remote prime switch location, 178

mailbox prefix
local prime switch location, 154
remote prime switch location, 179

mailbox, loopback, 131
main steps in implementation, 60
maintenance

as-required tasks, 220
backups following, 221
overview, 220
regularly scheduled tasks, 220

Meridian Mail system
remote site, 199

message
body contents, 67
handling scenario, 83
header contents, 66

parts, 47, 66
priorities, 67
transfer process, 82

message body contents, 67
Message Delivery Configuration dialog box, 

Enterprise tab, 126
message delivery parameters

modifying configuration, 235
message delivery parameters, configuring, 129
message handling, 78
Message Subject (Text), 52
message transfer protocol, modifying, 243
message transfer, main steps, 77
messages sent while system disabled, 232
messaging network, 136
Messaging Network Configuration tree view

adding sites, 136
messaging network representation

benefits, 99
coordination with other sites, 99
diagram, 98
implementation, 61
overview, 98
security, 99
spreadsheet, 98

migration guides, 18
modifying a remote site, 239
modifying channel resource allocation, 237
modifying configuration of Enterprise 

Networking, 228
modifying connection DN, 243
modifying dialing plan, 243, 248
modifying Enterprise Networking

announcing, 231
modifying Enterprise Site ID, 243
modifying message delivery parameters, 235
modifying message transfer protocol, 243
modifying passwords, 248
modifying records of remote users, 259
modifying remote site, 239

impact, 242
impact on network database, 240
preliminary requirement, 239

modifying remote site configuration, 242
MTA (Message Transfer Agent), description, 76
MTA Monitor, description, 76
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multi-administrator environment, deleting items 
from tree view, 245

Multiple Recipients, 51

N
name

local prime switch location, 153
local server, 145
local site, 142
remote prime switch location, 176
remote site, 167

Name Addressing, 50
Names Across the Network, 50, 146

adding remote users, 54
configuration examples, 54
limitations, 57
outgoing sessions, 58
overview, 54

network database, impact of modifying remote 
sites, 240

network history
contents, 222
overview, 222

network message service (NMS)
local site, 137

network protocol used with a remote site, 171
network representation, using to add and 

configure a remote site, 164
Network Usage Bill-back report, 226
networking

documentation, 20
networking solutions

configuration if implemented, 137
order of implementation, 64

NMS local site, configuring local prime switch 
location, 150

NMS site
spoken name imported for, 193
spoken name recorded for, 191

non-CallPilot remote sites, 197
non-CallPilot system

server type, 197
Norstar Voice Mail, remote site, 200

O
OM reports

importance of reviewing, 226
relevant for Enterprise Networking, 226
restricted access, 226

online guides, 22
online Help, accessing, 22
Open Networking Activity report, 226
outbound service directory number (SDN), 112
overlap

CDP steering code, 161
ESN location code, 157

P
parameters

default values, 68
Enterprise Networking, 68
set during implementation, 68

passwords
description, 72
modifying, 248

passwords for remote site, 172
Personal Distribution Lists, 50
personal verification recorded, remote user, 252
phantom DNs

relationship to service directory number 
(SDN), 108

required by Enterprise Networking, 117
ways to create, 118

planning guides, 18
prefix, mailbox, 154
Prime Switch Location Properties dialog box, 

151
CDP tab, 151
ESN tab, 151
General tab, 151
opening, 152
SMTP/VPIM tab, 151

printing
configuration information, 223
list of remote users, 258

priorities of messages, 67
Private Tag, 51
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protocol
Enterprise Networking, 47
used with a remote site, 171

Q
quick SDN test

evaluating results, 209
procedure, 209
purpose, 204

R
Received Time Announced, 52
receiving message text information, 147
Recipient’s Name (Text), 52
recommended order of implementation, 64
recording a spoken name, 192
regularly scheduled maintenance tasks, 220
remote messaging server

configuration if another messaging solution 
implemented, 166

configuration overview, 166
connection DN, 172
deleting, 245
Enterprise Site ID, 170
name, 167
network protocol used, 171
sending local user information to, 169
sending message text information, 170
sending messages to a remote site, 168
server FQDN, 170
server types supported, 168

Remote Messaging Server Properties dialog box
Connections tab, 171
General tab, 167

remote prime switch location
CDP information, 184
configuring ESN information, 182
dialing plan for dialing to this location, 178
dialing plan information, 178
Enterprise Location ID, 177
ESN information, 181
mailbox addressing follows dialing plan, 178
mailbox prefix, 179

name, 176
Remote Prime Switch Location Properties 

dialog box
CDP tab, 175
ESN tab, 175
General tab, 176
SMTP/VPIM tab, 175
tabs, 175

remote satellite switch location
configuration overview, 187
configuring, 189
dialing plan, 188
spoken name recorded, 188

Remote Satellite Switch Location Properties 
dialog box

CDP tab, 187
ESN tab, 187
tabs, 187

remote site
adding, 239
adding and configuring, 164
adding, modifying, and deleting, 239
checking configuration, 195
correcting information about, 165
deleting, 245
how to modify configuration, 244
information required to add and configure, 

164
locating, 241
Meridian Mail system, 199
modification impact, 242
modifying configuration, 239, 242
non-CallPilot, 197
Norstar Voice Mail system, 200
passwords, 172
using network representation to add and 

configure, 164
remote site name, 167
Remote Site Spoken Names, 51
remote sites

if other networking solutions implemented, 
137

main steps to add and configure, 164
remote switch location

configuration overview, 175
spoken name, 191, 193
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Remote Switch Location Properties dialog box, 
General tab, 175

remote switch location, information required, 
95

remote user
adding with User Administration, 251
DN, 252
finding, 254
last access time, 253
mailbox number, 252
maintenance overview, 250
manually deleting, 260
methods for finding, 254
modifying records of, 259
personal verification recorded, 252
printing list of, 258
status, 252
temporary, 54
time stamps, 58
when added and updated, 57

remote user information, sending, 58
remote users

adding with Names Across the Network, 54
examples of Names Across the Network, 54

Reply All, 51
Reply To, 51
reports for Enterprise Networking, 267
responding password, 172

description, 72
modifying, 248

restricting
message exchange, 145
sending messages to a remote site, 168

reviewing Alarm and Event reports, 267
reviewing OM reports, 226

what to look for, 268

S
satellite switch location, deleting, 245
scheduling backups, 215
Sender’s Department, 53
Sender’s Name (Text), 52
sending local user information to a remote site, 

169

sending message text information to a remote 
site, 170

sending messages to other sites, 145
Sent Time Announced, 52
server FQDN, 142, 147

remote site, 170
server type

local server, 145
non-CallPilot remote sites, 197
supported for remote messaging server, 168

service directory number (SDN)
adding and configuring new, 113
and DN setting on switch, 108
definition, 106
examples, 109
how to modify, 238
inbound, 106, 112
outbound, 106, 112
relationship to other numbers, 108
sharing existing inbound, 114

Service Directory Number (SDN) Table
description, 106
example, 107

Shared Distribution Lists, 51
site ID number, 48
site status errors, 265
SMTP/VPIM server FQDN, 142
SMTP/VPIM tab

Prime Switch Location Properties dialog box, 
151

Remote Prime Switch Location Properties 
dialog box, 175

speech recognition channel type, 108
Speech Recognition Messaging CDN queues, 

116
spoken name

for remote switch location, 191, 193
importing, 193, 194
importing for local NMS site, 193
recorded for remote satellite switch location, 

188
recording, 192
recording for local NMS site, 191
recording for local prime switch location, 153
recording overview, 191
ways to record, 177
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spreadsheet of messaging network, 98
stale time

description, 70
relationship to holding time, 128

stale time for economy messages, default value, 
124

stale time for standard messages, default value, 
124

stale time for urgent messages, default value, 
124

standard message, holding time, 69
standard priority message, 67
steering code for CDP, 161
switch

and directory numbers (DNs), 116
configuration changes, 248
configuring for Enterprise Networking, 61
confirming settings, 92
dialing plan information required, 91
Enterprise Networking requirements, 104
gathering information, 91
how an Enterprise Networking message is 

treated, 104
information required from, 93
information to gather, 61
mandatory requirements, 96
setting required for Enterprise Networking, 

116
switch backup, 215
switch configuration

preliminary requirements, 104
requirements for Enterprise Networking, 104

switch-related problems, 270
call trace, 265
call trace test, 271
link diagnostic test, 273

T
technical support, 23
temporary remote user, Names Across the 

Network, 54
test suite

call routing test, 204
end-to-end test, 205

local SDN test, 204
purpose, 204
quick SDN test, 204
tests included, 204

testing Enterprise Networking, 62
coordination required, 205
ensuring quick results, 205

testing with loopback mailbox, 132
text information in messages, 147
time stamps of remote users, 58
Timed Delivery, 53
tree view, deleting items, 245
troubleshooting

reference documentation, 22
technical support, 23

troubleshooting Enterprise Networking
configuration errors, 264
hardware problems, 265
identifying problem, 264
overview, 264
site status errors, 265
switch-related problems, 265

U
urgent message, 67

holding time, 69
Urgent Tag, 52
User Administration

adding a remote user, 251, 253
user guides, 21
User’s Actual Personal Verification, 51
using a loopback mailbox, 132

V
validation of information, 62
voice channel type, 108
Voice Messaging controlled directory number 

queue, 116
VPIM Networking, server FQDN of remote site, 

170
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W
ways to disable to disable Enterprise 

Networking, 233
ways to enable Enterprise Networking, 233
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